
HP UFT .NET Add-in Extensibility
For the Windows ® operating systems

Software Version: 11.50

Developer Guide

Document Release Date: October 2013

Software Release Date: September 2012



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice
© Copyright 1992 - 2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® andWindows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of TheOpenGroup.

HP UFT .NET Add-in Extensibility (11.50)Page 2 of 100

Developer Guide



Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Welcome to HP UFT .NET Add-in Extensibility
HP UFT .NET Add-in Extensibility is an SDK (Software Development Kit) package that enables
you to support testing applications that use third-party and custom .NETWindows Forms controls
that are not supported out-of-the-box by the UFT .NET Add-in.

This chapter includes:

About the UFT .NET Add-in Extensibility SDK 9

About the UFT .NET Add-in Extensibility Developer Guide 10

Who Should Read This Guide 11

Unified Functional Testing Help 11

Additional Online Resources 12
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About the UFT .NET Add-in Extensibility SDK
The UFT .NET Add-in Extensibility SDK installation provides the following:

l An API that enables you to extend the UFT .NET Add-in to support custom .NETWindows
Forms controls.

l Custom Server C# and Visual Basic project templates for Microsoft Visual Studio.

Each Custom Server template provides a framework of blank code, some sample code, and the
UFT project references required to build a custom server.

Note: For a list of supportedMicrosoft Visual Studio versions, see theHP Unified
Functional Testing Product Availability Matrix, available from the Unified Functional Testing
Help or the root folder of the Unified Functional Testing DVD.

l The wizard that runs when the Custom Server template is selected to create a new project. The
wizard simplifies setting up aMicrosoft Visual Studio project to create a Custom Server .NET
DLL using .NET Add-in Extensibility. For more information, see Using a .NET DLL to Extend
Support for a Custom Control.

l The .NET Add-inWindows Forms Extensibility Help, which includes the following:

n A developer guide, including a step-by-step tutorial in which you develop support for a sample
custom control.

n An API Reference.

n The .NET Add-in Extensibility Configuration SchemaHelp.

n The .NET Add-in Extensibility Control Definition SchemaHelp.

n The UFT Test Object SchemaHelp.

The Help is available from Start > All Programs > HP Software > HP Unified Functional
Testing > Extensibility > Documentation

l A printer-friendly Adobe portable document format (PDF) version of the developer guide
(available from Start > All Programs > HP Software > HP Unified Functional Testing >
Extensibility > Documentation and in the <Unified Functional Testing
installation>\help\Extensibility folder).

l A sample .NET Add-in Extensibility support set that extends UFT GUI testing support for the
SandBar toolbar custom control.

Developer Guide
Welcome to HP UFT .NET Add-in Extensibility
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Accessing UFT .NET Add-in Extensibility in Windows 8 Operating Systems
UFT files that were accessible from theStartmenu in previous versions of Windows are accessible
inWindows 8 from theStart screen or theApps screen.

l Applications (.exe files). You can access UFT applications inWindows 8 directly from the
Start screen. For example, to start UFT, double-click theHP Unified Functional Testing
shortcut.

l Non-program files. You can access documentation from theApps screen.

Note: As in previous versions of Windows, you can access context sensitive help in UFT
by pressing F1, and access complete documentation and external links from theHelp
menu.

About the UFT .NET Add-in Extensibility Developer
Guide

This guide explains how to set up UFT .NET Add-in Extensibility and use it to extend UFT GUI
testing support for third-party and custom .NETWindows Forms controls.

This guide assumes you are familiar with UFT functionality and should be used together with the
following sections of the .NET Add-in Extensibility online Help (Start > All Programs >
HP Software > HP Unified Functional Testing > Extensibility > Documentation > .NET
Add-in Windows Forms Extensibility Help):

l UFT .NET Add-in Extensibility API Reference

l UFT .NET Add-in Extensibility Systems Forms Configuration SchemaHelp

l UFT .NET Add-in Extensibility Control Definition SchemaHelp

l HP UFT Test Object SchemaHelp

These documents should also be used in conjunction with the following UFT documentation,
available with the UFT installation (Help > HP Unified Functional Testing Help from the UFT
main window):

l HP Unified Functional Testing User Guide

l The .NET section of theHP Unified Functional Testing Add-ins Guide

l HP UFT Object Model Reference for GUI Testing

Developer Guide
Welcome to HP UFT .NET Add-in Extensibility
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Note:

The information, examples, and screen captures in this guide focus specifically on working
with UFT GUI tests. However, much of the information in this guide applies equally to
business components.

Business components are part of HP Business Process Testing. For more information, see the
HP Unified Functional Testing User Guide and theHP Business Process Testing User Guide.

When working inWindows 8, access UFT documentation and other files from theApps
screen.

Who Should Read This Guide
This guide is intended for programmers, QA engineers, systems analysts, system designers, and
technical managers who want to extend UFT GUI testing support for .NETWindows Forms custom
controls.

To use this guide, you should be familiar with:

l Major UFT features and functionality

l The UFT Object Model

l UFT .NET Add-in

l .NET programming in C# or Visual Basic

l XML (basic knowledge)

Unified Functional Testing Help
The Unified Functional Testing Help provides a single-point of access for UFT documentation.

Developer Guide
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You can access the Unified Functional Testing Help by using the following:

l In UFT, select Help > HP Unified Functional Testing Help.

l In the Start menu on the UFT computer, select All Programs > HP Software > HP Unified
Functional Testing > Documentation > HP Unified Functional Testing Help.

Note:Whenworking inWindows 8, access UFT documentation and other files from the
Apps screen.

l Click in selected UFT windows and dialog boxes or press F1.

l View a description, syntax, and examples for a UFT test object, method, or property by placing
the cursor on it (in UFT) and pressing F1.

Additional Online Resources
The following additional online resources are available:

Resource Description

Troubleshooting
& Knowledge
Base

The Troubleshooting page on the HP Software Support Web site where you
can search the Self-solve knowledge base. The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software
Support

The HP Software Support Web site. This site enables you to browse the
Self-solve knowledge base. You can also post to and search user
discussion forums, submit support requests, download patches and updated
documentation, andmore. The URL for this Web site
www.hp.com/go/hpsoftwaresupport.

l Most of the support areas require that you register as an HP Passport
user and sign in. Many also require a support contract.

l To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

l To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html

HP Software
Web site

The HP SoftwareWeb site. This site provides you with themost up-to-date
information on HP Software products. This includes new software releases,
seminars and trade shows, customer support, andmore. The URL for this
Web site is www.hp.com/go/software

Developer Guide
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Chapter 1: Introducing UFT .NET Add-in
Extensibility

UFT .NET Add-in Extensibility enables you to provide high-level support for third-party and custom
.NETWindows Forms controls that are not supported out-of-the-box by the UFT .NET Add-in.

This chapter includes:

About UFT .NET Add-in Extensibility 14

DecidingWhen to Use .NET Add-in Extensibility 14

RecognizingWhich Elements of UFT Support Can BeCustomized 15

Example: Customizing Recording of an Event's Meaningful Behaviors 16

Understanding How to Implement .NET Add-in Extensibility 18

Planning the .NET Add-in Extensibility Support Set 18

Developing the .NET Add-in Extensibility Support Set 19

Deploying the .NET Add-in Extensibility Support Set 23

Testing the .NET Add-in Extensibility Support Set 23
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About UFT .NET Add-in Extensibility
The UFT .NET Add-in provides support for a number of commonly used .NETWindows Forms
controls. UFT .NET Add-in Extensibility enables you to support third-party and custom .NET
Windows Forms controls that are not supported out-of-the-box by the .NET Add-in.

When UFT learns an object in an application, it recognizes the object as belonging to a specific test
object class. This determines the identification properties and test object methods of the test object
that represents the application's object in UFT.

Without extensibility, .NETWindows Forms controls that are not supported out-of-the-box are
represented in UFT GUI tests by a generic SwfObject test object. This generic test object might be
missing characteristics that are specific to the .NETWindows Forms control you are testing.
Therefore, when you try to create test steps with this test object, the available test object methods
might not be sufficient. In addition, when you record a test on controls that are not supported, the
recorded steps reflect the low-level activities passed as Windows messages, rather than the
meaningful behavior of the controls.

Using UFT .NET Add-in Extensibility, you can teach UFT to recognize custom .NETWindows
Forms controls more specifically. When a custom control is mapped to an existing UFT test object,
you have the full functionality of a UFT test object, including visibility when using the UFT
statement completion feature and the ability to createmoremeaningful steps in the test.

Note: If UFT recognizes a .NET control out-of-the-box, and uses a .NET
add-in test object other than SwfObject to represent it, then you cannot map this control to any
other test object type.

The behavior of the existing test object methods might not be appropriate for the custom control.
You canmodify the behavior of existing test object methods, or extend UFT test objects with new
methods that represent themeaningful behaviors of the control.

You develop a Custom Server that extends the .NET Add-in interfaces that runmethods on the
controls in the application. The Custom Server can override existingmethods or define new ones.

Deciding When to Use .NET Add-in Extensibility
The UFT .NET Add-in provides a certain level of support for most .NETWindows Forms controls.
Before you extend support for a custom .NETWindows Forms control, analyze it from aUFT
perspective to view the extent of this support and to decide which elements of support you need to
modify.

When you analyze the custom .NETWindows Forms control, use the .NETWindows Forms Spy,
Keyword View, Editor, and the Record option. Make sure you examine each of the elements
described in "RecognizingWhich Elements of UFT Support Can BeCustomized" on the next page.
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If you are not satisfied with the existing object identification or behavior, your .NETWindows Forms
control is a candidate for .NET Add-in Extensibility, as illustrated in the following situations:

l UFT recognizes your control as a generic SwfObject, but a different test object class exists with
more appropriate behavior for your control. You can use .NET Add-in Extensibility to map the
control to this test object class.

l UFTmight recognize the control using a test object that does not fit your needs. You can use
.NET Add-in Extensibility to instruct UFT to change the functionality of the test object by
modifying its methods.

l UFTmight identify individual sub-controls within your custom control, but not properly identify
your main control. For example, if your main custom control is a digital clock with edit boxes
containing the hour andminute digits, youmight want changes in the time to be recognized as
SetTime operations on the clock control and not as Set operations on the edit boxes. You can
use .NET Add-in Extensibility to set amessage filter to process messages from child controls,
and record operations on themain control in response to events that occur on the controls it
contains.

Recognizing Which Elements of UFT Support Can
Be Customized

The following elements comprise UFT GUI testing support. By extending the existing support of
one or more of these elements, you can develop the support you need to createmeaningful and
maintainable tests.

Test Object Classes
In UFT, every object in an application is represented by a test object of a specific test object class.
The test object class determines the list of identification properties and test object methods
available in UFT for this test object. Youmight want to instruct UFT to use a different test object
class to represent your control.

Test Object Methods
The test object class used to represent the .NETWindows Forms control determines the list of test
object methods for a test object. However, the same test object methodmight operate differently
for different .NETWindows Forms controls represented by test objects from the same test object
class. This happens because depending on the specific type of .NETWindows Forms control, UFT
may have to perform the test object method differently.

Recording Events
Oneway to create UFT GUI tests is by recording user operations on the application. When you
start a recording session, UFT listens for events that occur on objects in the application and
registers corresponding test steps. The test object class and Custom Server used to represent a

Developer Guide
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.NETWindows Forms control determines which events UFT can listen for on the .NETWindows
Forms control and what test step to record for each event that occurs.

Example: Customizing Recording of an Event's
Meaningful Behaviors

A control's meaningful behavior is the behavior that you want to test. For example, when you click a
button in a radio button group in your application, you are interested in the value of the selection, not
in theClick event and the coordinates of the click. Themeaningful behavior of the radio button
group is the change in the selection.

If you record a test or business component on a custom control without extending support for the
control, you record the low-level behaviors of the control. For example, the TrackBar control in the
sample .NET application shown below is a control that does not have a corresponding UFT test
object.

If you record on the TrackBar without implementing support for the control, the Keyword View looks
like this:

In the Editor, the recorded test looks like this:

SwfWindow("Sample Application").SwfObject("trackBar1").Drag 50,10
SwfWindow("Sample Application").SwfObject("trackBar1").Drop 32,11
SwfWindow("Sample Application").SwfObject("trackBar1").Drag 34,11
SwfWindow("Sample Application").SwfObject("trackBar1").Drop 51,12
SwfWindow("Sample Application").SwfObject("trackBar1").Drag 50,4
SwfWindow("Sample Application").SwfObject("trackBar1").Drop 23,7
SwfWindow("Sample Application").SwfObject("trackBar1").Click 83,10

Developer Guide
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SwfWindow("Sample Application").SwfObject("trackBar1").Click 91,11
SwfWindow("Sample Application").SwfButton("Close").Click

Note that theDrag, Drop, andClickmethods—the low-level actions of the TrackBar control—are
recorded at specific coordinates in the control display. These steps are difficult to understand and
modify.

If you use .NET Add-in Extensibility to support the TrackBar control, the result is moremeaningful.
Below is the Keyword View of a test recorded on the TrackBar with a Custom Server that
implements a customizedSetValuemethod.

In the Editor, the recorded test looks like this:

SwfWindow("Sample Application").SwfObject("trackBar1").SetValue 5
SwfWindow("Sample Application").SwfObject("trackBar1").SetValue 0
SwfWindow("Sample Application").SwfObject("trackBar1").SetValue 10
SwfWindow("Sample Application").SwfObject("trackBar1").SetValue 6
SwfWindow("Sample Application").Close

UFT is now recording aSetValue operation reflecting the new slider position, instead of the low-
level Drag, Drop, andClick operations recorded without the customized test object. You can
understand andmodify this test more easily.

Developer Guide
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Understanding How to Implement .NET Add-in
Extensibility

You implement .NET Add-in Extensibility support for a set of custom controls by developing a .NET
Add-in Extensibility support set. Developing a .NET Add-in Extensibility support set consists of the
following stages, each of which is described below.

Planning the .NET Add-in Extensibility Support Set
Detailed planning of how you want UFT to recognize the custom controls enables you to correctly
build the fundamental elements of the .NET Add-in Extensibility support set. Generally, to plan the
support set, you:

l Determine the .NETWindows Forms controls for which you need to customize support.

l Plan the test object model by determining which test objects and operations you want to support
based on the controls and business processes you need to test.

l Plan themost appropriate way for implementing the support.

For more information, see "Planning Your Support Set" on page 30.

Developer Guide
Chapter 1: Introducing UFT .NET Add-in Extensibility

HP UFT .NET Add-in Extensibility (11.50) Page 18 of 100



Developing the .NET Add-in Extensibility Support Set
To develop a .NET Add-in Extensibility support set, youmust:

l Define the test object model.

l Create Custom Servers.

l Map the custom controls to the relevant test object classes.

These activities are described in detail in the following sections:

Define The Test Object Model
Introduce the test object model that you want UFT to use to test your applications and controls. The
test object model is a list of the test object classes that represent custom controls in your
environment, and their test object methods.

You define the test object model in a test object configuration XML file. For more information, see
"Describing the Test Object Model " on page 40.

Create Custom Servers
Create a Custom Server (DLLs or control definition XML file) to handle each custom control. In the
Custom Server, you canmodify:

l What steps are recorded during a recording session.

l The implementation of test object methods.

l Support for table checkpoints and output values.

The Custom Server mediates between UFT and the .NET application. During a recording session,
the Custom Server listens to events andmaps the user activities to meaningful test object
methods. During a test run, the Custom Server performs the test object methods on the .NET
Windows Forms control.

Custom Server Coding Options

The Custom Server can be implemented in one of the following coding options:

l .NET DLL

l XML, based on a schema (which UFT then uses to create a .NET DLLCustom Server behind
the scenes)

For more information, see:

l "Using a .NET DLL to Extend Support for a Custom Control" on page 47

l "Using XML Files to Extend Support for a Custom Control" on page 65

Developer Guide
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Custom Server Run-time Contexts

Classes supplied by a Custom Server may be instantiated in the following software processes (run-
time contexts):

l Application under test context: An object created in the context of the application you are
testing has direct access to the .NETWindows Forms control's events, methods, and
properties. However, it cannot listen toWindows messages.

l UFT context: An object created in the UFT context can listen toWindows messages. However,
it does not have direct access to the .NETWindows Forms control's events, methods, and
properties.

If the Custom Server is implemented as a .NET DLL, an object created under UFT can create
assistant classes that run under the application you are testing.

For more details on run-time contexts, see "Selecting the Custom Server Run-TimeContext
Depending on the Test Function" on page 34.

For more information on assistant classes, see "Using a .NET DLL to Extend Support for a Custom
Control" on page 47 and see the UFT .NET Add-in Extensibility API Reference.

Map the Custom Controls to the Relevant Test Objects
Map test objects using the .NET Add-in Extensibility configuration file (SwfConfig.xml). This file is
located in the <UFT installation path>\dat\ folder and contains:

l Themapping of the custom controls to their corresponding test objects.

l Themapping to corresponding Custom Servers. This mapping provides the full functionality to
UFT test objects.

For more information, see "Mapping Custom Controls to Test Object Classes" on page 46.

The illustrations below demonstrate how .NET Add-in Extensibility maps custom controls to their
test objects and Custom Servers during recording sessions and run sessions.

Developer Guide
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How UFT Maps Custom Controls to Test Object Classes During Recording

The following illustration and table explain how UFTmaps custom controls to their test objects,
locates the corresponding extended implementation for the custom control, and records an
appropriate test step when recording.

Step Description

1 An event occurs on a type of control that UFT does not recognize, or for which recording
implementation is customized.

2 UFT checks the Type attribute of theControl elements in theSwfConfig.xml file to
locate information for this type of custom control. UFT then checks theMappedTo
attribute, to find the test object class mapped to this type of control. If no specific test
object class is specified, SwfObject is used.

3 UFT checks theDLLName element in theSwfConfig.xml file to locate the Custom
Server containing implementation for this type of custom control, and communicates with
the Custom Server.

4 The Custom Server instructs UFT what step to add to the test in response to the event
that occurred.

Developer Guide
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How UFT Maps Custom Controls to Custom Servers When Running a Test

The following illustration and table explain how UFTmaps custom controls to their test objects,
locates the corresponding extended implementation for the custom control, and performs the
appropriate operations on a custom control when running a test.

Step Description

1 A test runs. This test includes a test object representing a custom control whose
implementation has been customized.

2 UFT locates theControl element in theSwfConfig.xml file that contains information for
the custom control mapped to this test object.

3 UFT checks theDLLName element in theSwfConfig.xml file to locate the Custom
Server containing implementation for the custom control.

4 UFT runs the test using the correct implementation for the test object operation as defined
by the implementation of the custom control.

Developer Guide
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Deploying the .NET Add-in Extensibility Support Set
To deploy your .NET Add-in Extensibility support set and enable UFT to support your controls, copy
the files you created to specific locations within the UFT installation folder.

For more information, see "Configuring and Deploying the Support Set" on page 70.

Testing the .NET Add-in Extensibility Support Set
After you have created the .NET Add-in Extensibility support for your controls, test your .NET Add-
in Extensibility support set.

You can learn how to develop a .NET Add-in Extensibility support set hands-on, by performing the
lessons in "Learning to Create Support for a Simple Custom .NETWindows Forms Control" on
page 80 and "Learning to Create Support for a Complex Custom .NETWindows Forms Control" on
page 90.
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Chapter 2: Installing the HP UFT .NET Add-in
Extensibility SDK

This chapter describes the installation process for the HP UFT .NET Add-in Extensibility SDK.

For a list of items that the HP UFT .NET Add-in Extensibility SDK installation provides, see "About
the UFT .NET Add-in Extensibility SDK " on page 9.

This chapter includes:

Before You Install 25

Installing the HP UFT .NET Add-in Extensibility SDK 25

Repairing the HP UFT .NET Add-in Extensibility SDK Installation 28

Uninstalling the HP UFT .NET Add-in Extensibility SDK 29
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Before You Install
Before you install the HP UFT .NET Add-in Extensibility SDK, review the following requirements:

l Youmust have access to the Unified Functional Testing installation DVD.

l A supported version of Microsoft Visual Studio must be installed on your computer.

Note: For a list of supportedMicrosoft Visual Studio versions, see theHP Unified
Functional Testing Product Availability Matrix, available from the Unified Functional Testing
Help or the root folder of the Unified Functional Testing DVD.

Installing the HP UFT .NET Add-in Extensibility
SDK

Use the HP Unified Functional Testing Setup program to install the HP UFT .NET Add-in
Extensibility SDK on your computer.

Note: Youmust be logged on with Administrator privileges to install the UFT .NET Add-in
Extensibility SDK.

To install the HP UFT .NET Add-in Extensibility SDK:

1. Close all instances of Microsoft Visual Studio.

2. Insert the Unified Functional Testing DVD into the CD-ROM/DVD drive. The Unified
Functional Testing Setup window opens. (If the window does not open, browse to the DVD and
double-click setup.exe from the root folder.)

3. Click Add-in Extensibility and Web 2.0 Toolkits. The Unified Functional Testing Add-in
Extensibility andWeb 2.0 Toolkit Support screen opens.

4. Click UFT .NET Add-in Extensibility SDK Setup. The UFT .NET Add-in Extensibility SDK
Setup wizard opens.

Note: If the wizard screen that enables you to select whether to repair or remove the SDK
installation opens, the UFT .NET Add-in Extensibility SDK is already installed on your
computer. Before you can install a new version, youmust first uninstall the existing one,
as described in "Uninstalling the HP UFT .NET Add-in Extensibility SDK" on page 29.

5. Follow the instructions in the wizard to complete the installation.
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6. In the final screen of the Setup wizard, if you select theShow Readme check box, the UFT
.NET Add-in Extensibility Readme file opens after you click Close. The Readme file contains
the latest technical and troubleshooting information. To open the Readme file at another time,
select Start > All Programs > HP Software > HP Unified Functional Testing >
Extensibility > Documentation > .NET Add-in Extensibility Readme.

Note:Whenworking inWindows 8, access UFT documentation and other files from the
Apps screen.

7. Click Close to exit the Setup wizard.

8. If you use a non-English edition of Visual Studio, do the following to apply the installedUFT
CustomServer project templates to your Visual Studio edition:

Note: The following instructions apply to Visual Studio 2008 installed on a 32-bit operating
system. The folder and file names are slightly different if you are working with Visual
Studio 2010, or on a 64-bit operating system.

a. Copy theQuickTestCustomServerVB.zip file from:%ProgramFiles%\
Microsoft Visual Studio 9.0\Common7\IDE\ProjectTemplates\VisualBasic\
Windows\1033 (English language setting folder) to the folder relevant to the language you
use (for example, use 1036 for French).

b. Run thePostCustomVizard.exe program from the%ProgramFiles%\Microsoft Visual
Studio 9.0\Common7\IDE folder.

c. Repeat this process for the C# template, copying theQuickTestCustomServer.zip file
from:%ProgramFiles%\Microsoft Visual Studio 9.0\Common7\IDE\
ProjectTemplates\CSharp\Windows\1033

To confirm that the installation was successful:

Note: TheMicrosoft Visual Studio dialog box illustration and the instructions in this procedure
refer to Microsoft Visual Studio 2008. If you use a different Microsoft Visual Studio version, the
dialog box may differ slightly in appearance and theUFT CustomServer templatemay be
located in a slightly different node in the tree.

1. Open a supported version of Microsoft Visual Studio.

For a list of supportedMicrosoft Visual Studio versions, see theHP Unified Functional Testing
Product Availability Matrix, available from the Unified Functional Testing Help or the root folder
of the Unified Functional Testing DVD.

2. Select File > New > Project to open the New Project dialog box.

3. Select theVisual Basic > Windows node in theProject types tree.
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4. Confirm that theUFT CustomServer template icon is displayed in the Templates pane:

5. Select theVisual C# > Windows node in theProject types tree.

6. Confirm that theUFT CustomServer template icon is displayed in the Templates pane.

Note: If you upgrade to a new version of Microsoft Visual Studio, youmust uninstall and
reinstall the .NET Add-in Extensibility SDK to be able to access theUFTCustomServer
template.
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Repairing the HP UFT .NET Add-in Extensibility
SDK Installation

You can use the Unified Functional Testing Setup program to repair an existing HP UFT .NET Add-
in SDK installation by replacing any missing or damaged files from your previous installation.

Note:

l Youmust use the same version of the setup program as you used for the original
installation.

l Youmust be logged on with Administrator privileges to repair the installation.

l If User Account Control (UAC) is available for your operating system, UAC must be turned
off while you repair the installation.

To repair the HP UFT .NET Add-in Extensibility SDK installation:

1. Insert the Unified Functional Testing DVD into the CD-ROM/DVD drive. The Unified
Functional Testing Setup window opens. (If the window does not open, browse to the DVD and
double-click setup.exe from the root folder.)

2. Click Add-in Extensibility and Web 2.0 Toolkits. The Unified Functional Testing Add-in
Extensibility andWeb 2.0 Toolkit Support screen opens.

3. Click UFT .NET Add-in Extensibility SDK Setup. The .NET Add-in Extensibility SDK Setup
wizard opens, enabling you to select whether to repair or remove the SDK installation.

4. Select Repair and click Finish. The setup program replaces the UFT .NET Add-in
Extensibility SDK files and opens the Installation Complete screen.

5. In the Installation Complete screen, click Close to exit the Setup wizard.
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Uninstalling the HP UFT .NET Add-in Extensibility
SDK

You can uninstall the HP UFT .NET Add-in SDK by usingAdd/Remove Programs as you would
for other installed programs. Alternatively, you can use the Unified Functional Testing Setup
program.

Note:

l Youmust use the same version of the setup program as you used for the original
installation.

l Youmust be logged on with Administrator privileges to uninstall the UFT .NET Add-in
Extensibility SDK.

To uninstall the HP UFT .NET Add-in Extensibility SDK:

1. Insert the Unified Functional Testing DVD into the CD-ROM/DVD drive. The Unified
Functional Testing Setup window opens. (If the window does not open, browse to the DVD and
double-click setup.exe from the root folder.)

2. Click Add-in Extensibility and Web 2.0 Toolkits. The Unified Functional Testing Add-in
Extensibility andWeb 2.0 Toolkit Support screen opens.

3. Click UFT .NET Add-in Extensibility SDK Setup. The .NET Add-in Extensibility SDK Setup
wizard opens, enabling you to select whether to repair or remove the SDK.

4. Select Remove and click Finish. The setup program removes the UFT .NET Add-in
Extensibility SDK and opens the Installation Complete screen.

5. In the Installation Complete screen, click Close to exit the Setup wizard.
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Chapter 3: Planning Your Support Set
Before you begin to create support for custom controls, youmust carefully plan the support.
Detailed planning of how you want UFT to recognize the custom controls enables you to correctly
build the fundamental elements of the .NET Add-in Extensibility support set.

This chapter includes:

About Planning UFT GUI Testing Support for Your .NET Add-in Extensibility Controls 31

Determining Information Related to Your Custom Controls 31

Analyzing the Custom Controls 31

Selecting the Coding Option for Implementing the Custom Servers 32

.NET DLL: Full Program Development Environment 33

XML Implementation 33

Selecting the Custom Server Run-TimeContext Depending on the Test Function 34

Analyzing Custom Controls andMapping Them to Test Objects 36

Using the .NET Add-in Extensibility Planning Checklist 37

.NET Add-in Extensibility Planning Checklist 38

Where Do YouGo from Here? 38
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About Planning UFT GUI Testing Support for Your
.NET Add-in Extensibility Controls

Extending the UFT .NET Add-in's support to recognize custom .NETWindows Forms controls is a
process that requires detailed planning. To assist you with this, the sections in this chapter include
sets of questions related to the implementation of support for your custom controls. When you
create your .NET Add-in Extensibility support set, you implement it based on the answers you
provide to these questions.

Determining Information Related to Your Custom
Controls

Decide which controls this support set will support.

Before you begin planning support for custom .NETWindows Forms controls, make sure you have
full access to the controls and understand their behavior.

Youmust have an application in which you can view the controls in action.

Youmust also be able to view the source that implements them. You do not need tomodify any of a
custom control's sources to support it in UFT, but you do need to be familiar with them.

When planning custom support for a specific type of control, carefully consider how you want UFT
to recognize controls of this type—what type of test object you want to represent the controls in
UFT GUI tests, which test object methods you want to use, and so on. Make these decisions
based on the business processes that might be tested using this type of control and operations that
users are expected to perform on these controls:

l Make sure you know themethods the control supports, what properties it has, the events for
which you can listen, and so on.

l Identify existing test object classes whose functionality is similar to that of the custom .NET
Windows Forms controls.

l Decide what methods need to be written or modified for supporting the controls.

Analyzing the Custom Controls
You can run an application containing the custom control and analyze the control from aUFT
perspective using the .NETWindows Forms Spy, the Keyword View, and the Record option. This
enables you to see how UFT recognizes the control without custom support, and helps you to
determine what you want to change.
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Using the .NET Windows Forms Spy
You can use the .NETWindows Forms Spy to help you develop extensibility for .NETWindows
Forms controls. The .NETWindows Forms Spy enables you to:

l View details about selected .NETWindows Forms controls and their run-time object properties.

l Seewhich events cause your application to change (to facilitate record and run extensibility
implementation) and how the changes manifest themselves in the control's state.

You access the .NETWindows Forms Spy by choosing Tools > .NET Windows Forms Spy in
themain UFT window.

Note: To spy on a .NETWindows Forms application, make sure that the application is running
with Full Trust. If the application is not defined to run with Full Trust, you cannot spy on the
application's .NETWindows Forms controls with the .NETWindows Forms Spy. For
information on defining trust levels for .NET applications, see the relevant Microsoft
documentation.

For more information on the .NETWindows Forms Spy, see theHP Unified Functional Testing
Add-ins Guide.

When you plan the support for a specific control, youmust ask yourself a series of questions. You
can find a list of these questions in "Using the .NET Add-in Extensibility Planning Checklist" on
page 37. When you are familiar with the questions and you are designing your own custom support
classes, you can use the abbreviated, printable checklist on page 38.

Selecting the Coding Option for Implementing the
Custom Servers

You can implement custom support for custom .NETWindows Forms controls in the following
ways:

l .NET DLL. Extends support for the control using a .NET Assembly.

l XML. Extends support for the control using an XML file, based on a schema.
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.NET DLL: Full Program Development Environment
Most Custom Servers are implemented as a .NET DLL. This option is generally preferred because:

l Development is supported by all the services of the program development environment, such as
syntax checking, debugging, andMicrosoft IntelliSense.

l If table checkpoint and output value support is needed, this support is available only when
implementing the Custom Server as a .NET DLL.

l A Custom Server implemented as a .NET DLL can perform part of its Test Record functions in
the UFT context and part in the context of the application being tested. For more information,
see "Using a .NET DLL to Extend Support for a Custom Control" on page 47, and theUFT .NET
Add-in Extensibility API Reference (available in the UFT .NET Add-in Extensibility online Help.)

For information on run-time contexts, see "Selecting the Custom Server Run-TimeContext
Depending on the Test Function" on the next page.

XML Implementation
There are circumstances when it is most practical to implement Custom Servers using the XML
codingmethod. These circumstances include:

l When the controls are relatively simple and well documented.

l When the controls map well to an existing object, but you need to replace the implementation
during a recording session (Test Record), or replace or add a small number of test object
methods during a run session (Test Run).

l When a full programming environment is not available–implementation using XMLCustom
Servers requires only a text editor.

However, when implementing a custom control with XML:

l You have none of the support provided by a program development environment.

l The XML implementation includes C# programming commands, and runs only in the
Application under test context.

For more information, see "Using XML Files to Extend Support for a Custom Control" on page 65.
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Selecting the Custom Server Run-Time Context
Depending on the Test Function

Each Custom Server may implement the following test functions for each control:

l Test Record

l Test Run

l Table Verification (to support checkpoints and output values)

l A combination of these test functions

Run-time contexts include:

l Application under test: The context of the application which is being tested.

l UFT: The UFT context.

The following table provides guidelines for determining which test function you can implement for
each run-time context.

Need /
Task

Test
Record

Test
Run

Table
Verification

Run-Time
Context Explanation

Create
tasks using
keyword-
driven
testing (and
not by
recording
steps on an
application)

Not
applicable

Yes Only for
.NET DLL
Custom
Servers

Either
Application
under test
orUFT

The Test Record test
function records the actions
performed on the
application being tested and
the application's resulting
behaviors. The recording is
then converted to a test. If
you plan to create GUI tests
using keyword-driven
testing, and not by
recording steps on an
application, you do not need
to implement the Test
Record function.
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Need /
Task

Test
Record

Test
Run

Table
Verification

Run-Time
Context Explanation

Implement
the Custom
Server in the
Application
under test
context

Optional Optional
(usually)

Only for
.NET DLL
Custom
Servers

Application
under test

The Test Run function tests
if the application is
performing as required by
running the test and
tracking the results. Test
Run is nearly always
implemented in the
Application under test
context.

Listen to
Microsoft
Windows
messages

Yes Only
with
assistant
classes

Only for
.NET DLL
Custom
Servers

UFT If the .NET DLLCustom
Server must both listen to
Windows messages and
access control events and
properties, use assistant
classes. The Custom
Server running in theUFT
context can listen to events
in theApplication under
test context with assistant
class objects that run in the
Application under test
context. These objects also
provide direct access to
control properties.

Implement
table
checkpoints
and output
values on
custom grid
controls

Optional Optional Only for
.NET DLL
Custom
Servers

Either
Application
under test
orUFT

You can implement support
for table checkpoints and
output values on custom
grid controls, regardless of
the context in which your
.NET DLL runs.

Your
application
uses UFT
services
more than it
uses
services of
the custom
control

Yes, but
possibly
less
efficient

Possibly
more
efficient

Possibly
more
efficient

UFT is
preferred

There is no need to listen to
Windows messages during
a Test Run session, so the
UFT context is not required.
However, if your application
uses UFT services more
than it uses services of the
custom control, it may be
more efficient to implement
Test Run in theUFT
context.
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Analyzing Custom Controls and Mapping Them to
Test Objects

When you develop .NET Add-in Extensibility, youmap custom .NETWindows Forms controls to
existing UFT .NET Add-in test object classes and to Custom Servers that you develop.

The first mapping determines the test object class that UFT uses to represent the custom control.
The second specifies the Custom Server to use. The Custom Server extends the functionality of
the test object that is used for the control to match the control's functionality.

If UFT recognizes a .NET control out-of-the-box, and uses a .NET add-in test object other than
SwfObject to represent it (for example SwfEdit or SwfList), then you cannot map this control to any
other test object type. However, you can still map it to a Custom Server and extend the test object
functionality.

Mapping Custom Controls to Test Objects
Map the custom controls to test objects by using theMappedTo attribute in the UFT .NET Add-in
Extensibility's SystemWindows Forms configuration file (SwfConfig.xml). Map each custom
control to a UFT test object class containing behaviors that are similar to those required to support
your control.

If you do not specify amapping, UFT maps the custom control to the default generic test object,
SwfObject. For more information onSwfConfig.xml, see "Understanding How to Configure UFT
Windows Forms Extensibility" on page 71.

Note: Mapping is sometimes sufficient without any programming. If the existing UFT test
object adequately covers a control, it is sufficient to map the control to the UFT test object.

Mapping Custom Controls to Custom Servers
When youmap your control to a functionally similar UFT test object, then, in your Custom Server,
you do not need to override test object methods that apply without change to your custom control.
For example, most controls contain aClickmethod. If theClickmethod of the existing test object
implements theClickmethod of the custom control adequately, you do not need to override the
existing object's method.

To cover the Test Run functionality of the custom object that does not exist in the existing object,
add new methods in your Custom Server. To cover functionality that has the samemethod name,
but a different implementation, override the existing object's methods.

If the UFT test object adequately covers Test Record, but you need to customize Test Run, do not
implement Test Record. If you do implement Test Record, the implementation replaces that of the
existing object. Youmust implement all required Test Record functionality.

In UFT, when you edit a step with the test object that you customized to support the custom
control, the statement completion feature displays the custom properties andmethods that you
defined for the test object, in addition to those that exist in UFT. UFT uses test object configuration
files to provide the list of custom test object methods and properties.
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Using the .NET Add-in Extensibility Planning
Checklist

When you plan the support for a specific type of control, youmust ask yourself a series of
questions. These are explained below and are available in an abbreviated, printable checklist on
page 38.

1. Make sure you have access to an application that runs the custom control on a computer with
UFT installed.

2. Choose a .NETWindows Forms test object class to represent the custom control. (UFT uses
SwfObject by default)

3. Does the test object class you selected have to be customized?

a. Specify any test object methods that you want to add to the test object definition. Specify
themethod argument types and names, and whether themethod returns a value in addition
to the return code.

When you design the .NET Add-in Extensibility support set, you specify this information in
the test object configuration file.

b. Specify any test object methods whose behavior you want to modify or override.

When you design the .NET Add-in Extensibility Custom Server, you will need to implement
any new test object methods that you add, or any test object methods whose existing
behavior you want to override.

4. Should test objects of this class be displayed in the .NETWindows Forms Spy? (By default
they are.)

5. Are you going to provide support for recording? If so, list the events that should trigger
recording.

6. If you are creating support for a table control, decide whether you want to provide support for
table checkpoints and output values on this control.
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.NET Add-in Extensibility Planning Checklist
Use this checklist to plan the support for your custom control:

Custom Control Support Planning
Checklist

Specify in
Test Object
Config.
file?

Specify in .NET
Add-in Extensibility
configuration file?

Specify
in
Custom
Server?

q The sources for this custom control are
located in:

q Specify the .NET test object class to
map to the control: (Default—
SwfObject)

q Specify the test object methods you
want to add or modify (if required,
include arguments, and return values):

q Display test objects of this class in the
.NETWindows Forms Spy?
Yes (default)/No

q Provide support for recording?
Yes/No

If so, list the events that should trigger
recording:

q Provide support for table checkpoints
and output values?
Yes/No

Where Do You Go from Here?
After you finish planning the custom control support, you create the .NET Add-in Extensibility
support set."Developing Your Support Set" on page 39 explains how to develop the .NET Add-in
Extensibility support set.
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Chapter 4: Developing Your Support Set
This chapter explains how to develop extended support for custom .NETWindows Forms controls.
It explains which files you have to create for a .NET Add-in Extensibility support set, the structure
and content of these files, and how to develop them to support the different UFT capabilities for
your environment.

Note: Before you actually begin to create a support set, youmust plan it carefully. For more
information, see "Planning Your Support Set" on page 30.

For information on where the .NET Add-in Extensibility support set files should be stored to activate
the support you design, see "Configuring and Deploying the Support Set" on page 70.

This chapter includes:

Understanding the Development Workflow 40

Describing the Test Object Model 40

Benefits of Describing Test Object Models 41

Creating Test Object Configuration Files 41

Understanding the Contents of the Test Object Configuration File 42

Modifying an Existing Test Object Class 43

Make Sure that Test Object Configuration File InformationMatches Custom Server
Information 43

ImplementingMore ThanOne Test Object Configuration File 44

Example of a Test Object Configuration File 45

Mapping Custom Controls to Test Object Classes 46

Defining How UFT Operates on the Custom Controls 46

Using a .NET DLL to Extend Support for a Custom Control 47

Using XML Files to Extend Support for a Custom Control 65

Using the .NET Add-in Extensibility Samples 67

Troubleshooting and Limitations - Running the Support You Designed 68
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Understanding the Development Workflow
Implementing the .NET Add-in Extensibility support set consists of the following stages. The
workflow for developing the support set is described in the following sections.

Describing the Test Object Model
The first stage of developing support for custom controls is to introduce the test object model that
you want UFT to use to test your applications and controls. The test object model is a list of the test
object classes that represent custom controls in your environment and the syntax of the test object
methods that support the custom controls.

You define the test object model in a test object configuration file according to a specific XML
schema. For details about how to create test object configuration files, see "Creating Test Object
Configuration Files" on the next page.
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Benefits of Describing Test Object Models
Implementation of a test object configuration file is optional. If you choose not to implement the test
object configuration file, the test object methods defined in the .NET Custom Server DLL or control
definition files will work as expected, but the functionality listed below will bemissing.

Describing your custom test object methods in a test object configuration file enables the following
functionality when editing GUI tests in UFT:

l A list of available custom test object methods in theOperations column in the Keyword view
and when using the statement completion feature in the Editor.

l A test object method selected by default in the Keyword View and StepGenerator when a step
is generated for a test object of this class.

l Documentation for the custom test object methods in theDocumentation column in the
Keyword view.

l Icons and context-sensitive Help (only for new test object methods added to a test object class).

Creating Test Object Configuration Files
The following steps describe how to create test object configuration files.

To create test object configuration files:

1. Create a copy of the <UFT installation folder>\dat\Extensibility\DotNet\
DotNetCustomServerMethods.xml file to create a new test object configuration file in the
same folder. (Do not modify the original file.)

2. Edit the new test object configuration file, modifying any test object classes whose behavior
you want to modify. Delete any test object classes that you do not modify.

3. Save and close the test object configuration file.

For more information, see:

l "Understanding the Contents of the Test Object Configuration File" on the next page

l "Modifying an Existing Test Object Class" on page 43

l " Make Sure that Test Object Configuration File InformationMatches Custom Server
Information" on page 43

l " ImplementingMore ThanOne Test Object Configuration File" on page 44

l "Example of a Test Object Configuration File" on page 45

l UFT .NET Add-in Extensibility API Reference

Developer Guide
Chapter 4: Developing Your Support Set

HP UFT .NET Add-in Extensibility (11.50)Page 41 of 100



Understanding the Contents of the Test Object
Configuration File

A test object configuration file can include the following:

l The name of the test object class and its attributes.

l The name of the custom control for which this test object class definition is relevant.

l Themethods for the test object class, including the following information for eachmethod:

n The arguments, including the argument type and direction.

n Whether the argument is mandatory, and, if not, its default value.

n The description (shown as a tooltip in the Keyword View, Editor, and StepGenerator).

n The documentation string (shown in theDocumentation column of the Keyword View and in
the StepGenerator).

n A context-sensitive Help topic to open when F1 is pressed for the test object method in the
Keyword View or Editor, or when theOperation Help button is clicked for themethod in the
StepGenerator. The definition includes the Help file path and the relevant Help ID within the
file. (Relevant only for new test object methods added to the test object class.)

n The return value type.

l The test object method that is selected by default in the Keyword View and StepGenerator
when a step is generated for a test object of this class.

The following example shows parts of theSwfObject test object class definition in a test object
configuration file. The example shows that theSwfObject is extended by adding a
MyCustomButtonSetmethod. Themethod has one argument (Percent, which defines the
percentage to set in the control), and it also has a documentation string that appears in the Keyword
View:

</TypeInformation>
...
    <ClassInfo BaseClassInfoName="SwfObject" Name="MyCompany.MyButton">
...
        <TypeInfo>
            <Operation Name="MyCustomButtonSet"

PropertyType="Method" ExposureLevel="CommonUsed">
                  <Description>Set the percentage in the task bar</Descripti
on>
                  <Documentation><![CDATA[Set the %l %t to <Percent> percen
t.]]></Documentation>
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                    <Argument Name="Percent" IsMandatory="true" Direction="I
n">
                        <Type VariantType="Integer"/>
                        <Description>The percentage to set in the task bar.<
/Description>
                    </Argument>
            </Operation>
        </TypeInfo>
    </ClassInfo>
</TypeInformation>

For information on the structure and syntax of a test object configuration file, see theHP UFT Test
Object SchemaHelp (available with the UFT .NET Add-in Extensibility online help).

Modifying an Existing Test Object Class
Identify a test object class that provides partial support for your control, but needs some
modification, for example, additional or modified test object methods.

You can then extend the functionality of this test object by defining and implementing additional test
object methods. In addition, you can override existing test object methods by providing an alternate
implementation for them. You define the new or changedmethods in the test object configuration
file, and design their implementation using Custom Servers.

Adding Test Object Methods to an Existing Test Object
Class

When you create a test object class definition in the test object configuration file, you specify the
custom control for which this definition is relevant. (In theClassInfo element, you specify the test
object class in theBaseClassInfoName attribute, and the name of the custom class in theName
attribute.)

If you then add a custom test object method to the definition of this test object class, this method is
available in UFT only for test objects that represent custom controls of the type you specified.

For example, if you added aSetmethod to the SwfEditor test object class when used for
MyCompany.MyButton controls, then themethod is displayed in the statement completion list of
test object methods in UFT only for objects that represent such controls. When SwfEditor test
objects are used for other types of controls, this method will not be available.

Make Sure that Test Object Configuration File
Information Matches Custom Server Information

Make sure that the information you define in the test object configuration file exactly matches the
corresponding information defined in the .NET Custom Server DLL or control definition files. For
example, the test object method names must be exactly the same in both locations. Otherwise, the
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methods will appear to be available (for example, when using the statement completion feature) but
they will not work, and, if used, the run session will fail. In addition, the custom control name
specified in the test object configuration file must be the same as the name specified in the .NET
Add-in Extensibility configuration file.

Implementing More Than One Test Object
Configuration File

You can choose to implement one or multiple test object configuration files (or none, if not needed).
For example, you can define custommethods for one test object class in one test object
configuration file, and custommethods for another test object in a different test object configuration
file. You can also choose to define a group of custommethods for a test object class in one test
object configuration file, and another group of custommethods for the same test object class in a
different test object configuration file.

Each time you open UFT, it reads all of the test object configuration files andmerges the
information for each test object class from the different files into a single test object class definition.
This enables you to use the same test object class definitions when supporting different custom
toolkits.

Understanding How UFT Merges Test Object
Configuration Files

Each time you open UFT, it reads all of the test object configuration files located in the <UFT
installation folder>\dat\Extensibility\<UFT add-in name> folders. UFT thenmerges the
information for each test object class from the different files into a single test object class definition,
according to the priority of each test object configuration file.

UFT ignores the definitions in a test object configuration file in the following situations:

l The Load attribute of the TypeInformation element is set to false.

l The environment relevant to the test object configuration file is displayed in the Add-in Manager
dialog box, and the UFT user selects not to load the environment.

Define the priority of each test object configuration file using thePriority attribute of the
TypeInformation element.

If the priority of a test object configuration file is higher than the existing class definitions, it
overrides any existing test object class definitions, including built-in UFT information. For this
reason, be aware of any built-in functionality that will be overridden before you change the priority of
a test object configuration file.

Whenmultiple test object class definitions exist, UFT must handle any conflicts that arise. The
following sections describe the process UFT follows whenClassInfo, ListOfValues, and
Operation elements are defined inmultiple test object configuration files. All of the
IdentificationProperty elements for a specific test object class must be defined in only one test
object configuration file.
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ClassInfo Elements

l If aClassInfo element is defined in a test object configuration file with a priority higher than the
existing definition, the information is appended to any existing definition. If a conflict arises
betweenClassInfo definitions in different files, the definition in the file with the higher priority
overrides (replaces) the information in the file with the lower priority.

l If aClassInfo element is defined in a test object configuration file with a priority that is equal to
or lower than the existing definition, the differing information is appended to the existing
definition. If a conflict arises betweenClassInfo definitions in different files, the definition in the
file with the lower priority is ignored.

ListOfValues Elements

l If a conflict arises between ListOfValues definitions in different files, the definition in the file
with the higher priority overrides (replaces) the information in the file with the lower priority (the
definitions are not merged).

l If a ListOfValues definition overrides an existing list, the new list is updated for all arguments of
typeEnumeration that are defined for operations of classes in the same test object
configuration file.

l If a ListOfValues is defined in a configuration file with a lower priority than the existing definition,
the lower priority definition is ignored.

Operation Elements

l Operation element definitions are either added, ignored, or overridden, depending on the priority
of the test object configuration file.

l If anOperation element is defined in a test object configuration file with a priority higher than the
existing definition, the operation is added to the existing definition for the class. If a conflict
arises betweenOperation definitions in different files, the definition in the file with the higher
priority overrides (replaces) the definition with the lower priority (the definitions are not merged).

For more information, see theHP UFT Test Object SchemaHelp (available with the .NET Add-in
Extensibility SDK Help).

Example of a Test Object Configuration File
The following example shows the definition of the ToolStrip test object:

<ClassInfo Name="System.Windows.Forms.ToolStrip" aseClassInfoName="SwfToolBa
r" FilterLevel="1">
    <TypeInfo>
        <Operation Name="Select" PropertyType="Method ExposureLevel="CommonU
sed" SortLevel="-1">
            <Description>Selects a menu item from a SwfToolBar dropdown menu.
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            </Description>
            <Argument Name="Item" Direction="In" IsMandatory="true">
                <Type VariantType="VT_BSTR"/>
            </Argument>
        </Operation>
        <Operation Name="IsItemEnabled" PropertyType="Method" ExposureLevel=
"Expert" SortLevel="-1">
            <Description>Indicates whether the toolbar item is enabled.</Des
cription>
            <Argument Name="Item" Direction="In" IsMandatory="true">
                <Type VariantType="VT_BSTR"/>
            </Argument>
            <ReturnValueType><Type VariantType="VT_BOOL"/></ReturnValueType>
        </Operation>
        <Operation Name="ItemExists" PropertyType="Method" ExposureLevel="Ex
pert" SortLevel="-1">
            <Description>Indicates whether the specified toolbar item exists
.</Description>
            <Argument Name="Item" Direction="In" IsMandatory="true">
                <Type VariantType="VT_BSTR"/>
            </Argument>
            <ReturnValueType> <Type VariantType="VT_BOOL"/></ReturnValueType>
        </Operation>
    </TypeInfo>
</ClassInfo>

This example shows that the ToolStrip test object class extends theSwfToolBar test object
class. The default test object method for the ToolStrip test object class is Select (which has one
mandatory input parameter: Item).

Mapping Custom Controls to Test Object Classes
Themapping of custom controls to test object classes is defined in the .NET Add-in Extensibility
configuration file, SwfConfig.xml, in the <UFT installation path>\dat folder. This XML file
describes which test object class represents each custom control and where UFT can locate the
information it needs to interact with each control. For more information onmapping, see
"Configuring UFT to Use the Custom Server" on page 71.

Defining How UFT Operates on the Custom
Controls

After enabling UFT to recognize the custom controls, youmust provide support for running test
object methods. If you try to run a test with steps that run custom test object methods before
providing implementation for thesemethods, the test fails and a run-time error occurs.
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Custom Servers contain the implementation for how UFT interacts with the custom controls.
Custom Servers can be .DLL files or .XML files (which UFT converts to .DLL files "behind the
scenes" when necessary). For instructions on deciding when it is appropriate to use eachmethod,
see "Planning Your Support Set" on page 30.

l Most implementations are developed using DLL files. For more information, see "Using a .NET
DLL to Extend Support for a Custom Control" below.

l Simpler implementations can be developed using the XML files, by creating a Control Definition
file for each custom control. For more information, see "Using XML Files to Extend Support for a
Custom Control" on page 65.

After creating the Custom Server, configure UFT to use it. For more information, see "Configuring
UFT to Use the Custom Server" on page 71.

Using a .NET DLL to Extend Support for a Custom
Control

You can support a .NETWindows Forms control by creating a Custom Server implemented as a
.NET DLL. Set up a .NET project in Microsoft Visual Studio as a .NET DLL class library that
implements the interfaces for a combination of:

l Test Record (IRecord interface)

l Test Run (Replay interface)

l Table verification (supports checkpoints and output values)

Note: The IRecord interface is provided in the UFT .NET Add-in Extensibility SDK. When
running the UFT Custom Server Settings wizard to create a .NET DLLCustom Server, the
wizard provides code that implements the IRecord interface to get you started.

The SDK does not provide interfaces for replay and table verification. Youmust implement
these.

For details, see "Implementing the IRecord Interface" on page 54 and theUFT .NET Add-in
Extensibility API Reference (available in the UFT .NET Add-in Extensibility online Help.)

To create a .NET DLLCustom Server you need to know how to program a .NET Assembly. The
illustrations and instructions in this section assume that you are usingMicrosoft Visual Studio 2008
as your development environment and that the Custom Server Project Templates are installed. For
more information, see "Installing the HP UFT .NET Add-in Extensibility SDK" on page 24.

Considerations for Working with Custom Server DLLs

l The Custom Server DLL that you design is loaded into the 32-bit UFT application, and into the
application you are testing. Therefore, to enable your support to work with 64-bit applications,
youmust build your custom server DLLs with thePlatform target option set toAny CPU.
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l Applications running under .NET Framework version 1.1 cannot use DLLs that were created
using Visual Studio 2005 or above. Therefore you cannot use a Custom Server that you
implemented as a .NET DLL using Visual Studio 2005 or above when you run the application you
are testing under .NET Framework version 1.1.

l UFT loads the Custom Server when you open a test. Therefore, if you implement your Custom
Server as a .NET DLL, any changes youmake to the DLL after the Custom Server is loaded
take effect only the next time you open a test.

Designing the Custom Server DLL
Implementing your Custom Server as a .NET DLL involves the following tasks:

l "Setting up the .NET Project" (described on page 48)

l "Implementing Test Record for a Custom Control Using a .NET DLL" (described on page 54)

l " Implementing Test Run for a Custom Control Using the .NET DLL" (described on page 58)

l "Implementing Support for Table Checkpoints andOutput Values in the .NET DLLCustom
Server" (described on page 58)

l "Running Code under Application Under Test from the UFT Context" (described on page 63)

Setting up the .NET Project
Set up a .NET project in Microsoft Visual Studio using the Custom Server C# Project Template or
the Custom Server Visual Basic Project Template. (This template is installed automatically during
the installation, as described in "Installing the HP UFT .NET Add-in Extensibility SDK" on page 24).

When you set up the .NET project, the Custom Server Project template does the following:

l Creates the project files necessary for the build of the .DLL file.

l Sets up a C# or Visual Basic file (depending on which template you selected) with commented
code that contains the definitions of methods that you can override when you implement Test
Record or Test Run.

l Provides sample code that demonstrates some Test Record and Test Run implementation
techniques.

l Creates an XML file segment with definitions for the Custom Server that you can copy into the
.NET Add-in Extensibility configuration file (SwfConfig.xml).

To set up a new .NET project:

Caution: To use the Custom Server Project template to create a .NET project, youmust have
either administrator privileges or full read and write access to the following folder and all of its
sub-folders: <Microsoft Visual Studio installation folder>\VC#\VC#Wizards
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1. Start Microsoft Visual Studio.

2. Select File > New > Project to open the New Project dialog box, or press CTRL + SHIFT + N.
The New Project dialog box opens.

3. Select theVisual C# > Windows orVisual Basic > Windows node in theProject types
tree.

Note: In Microsoft Visual Studio versions other than 2008, the dialog box may differ
slightly in appearance and theUFT CustomServer templatemay be located in a slightly
different node in the tree.
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4. Select theUFT CustomServer template in the Templates pane. Enter the name of your new
project and the location in which you want to save the project. Click OK. The UFT Custom
Server Settings wizard opens.
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5. Determine whether your Custom Server will extend Test Record support, Test Run support, or
both, by making selections in the Application Settings page of the wizard.

n In theServer class name box, provide a descriptive name for your Custom Server class.

n Select theCustomize Record process check box if you intend to implement the Test
Record process in UFT.

If you select theCustomize Record process check box, the wizard creates a framework
of code for the implementation of recording steps.

Do not select this check box if you are going to create the test manually in UFT, or if you are
going to use the Test Record functions of the existing test object to which this control will be
mapped. Your Test Record implementation does not inherit from the existing test object to
which the custom control is mapped. It replaces the existing object's Test Record
implementation entirely. Therefore, if you need any of the existing object's functionality,
code it explicitly.

n Select theCustomize Run process check box if you intend to implement Test Run
functions for the custom control (meaning, if you are going to override any of the existing
test object's methods, or extend the test object with new methods). Enter a name for the
replay interface you will create in theReplay interface name box.

If you select theCustomize Run process check box, the wizard creates a framework of
code to implement Test Run support.

n Select theGenerate comments and sample code check box if you want the wizard to add
comments and samples in the code that it generates.
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6. Click Next. The XMLConfiguration Settings page of the wizard opens:
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7. Using the XMLConfiguration Settings page of the wizard, you can generate a segment of XML
code that can be copied into the .NET Add-in Extensibility configuration file (SwfConfig.xml).
This file maps the custom control to the test object, and provides UFT with the location of the
test object's Custom Server. (If you choose not to generate the XML configuration segment,
you canmanually edit the .NET Add-in Extensibility configuration file later.) For instructions on
copying this segment into theSwfConfig.xml file, see "Copying Configuration Information
Generated by the UFT Custom Server Settings Wizard" on page 73.

n Select theAuto-generate the XML configuration segment check box to instruct the
wizard to create the configuration segment, which is saved in theConfiguration.xml file.

n In theCustomized Control type box, enter the full type name of the control for which you
are creating the Custom Server, including all wrapping namespaces, for example,
System.Windows.Forms.CustCheckBox.

Note: If you want to specify a control type that is included inmore than one assembly
you can include the name of the assembly, or other information that will fully qualify the
type. For example, you could enter values similar to these:
- System.Windows.Forms.CustCheckBox, System2.Windows.Forms.v8.5
- System.Windows.Forms.CustCheckBox, System2.Windows.Forms.v8.5,
Version=8.5.20072.1093, Culture=neutral,
PublicKeyToken=8aa4d5436b5ad4cd
This can be useful, for example, if you have different versions of the control in your
application.

n In theMapped to box, select the test object to which you want to map the Custom Server.
If you select No mapping, the Custom Server is automatically mapped to theSwfObject
test object.

For more information, see "Map the Custom Controls to the Relevant Test Objects " on
page 20.

n Select the run-time context for Test Record and/or Test Run: the context of the application
that is being tested (Application under test) or the context of UFT (QuickTest).

For more information, see "Create Custom Servers" on page 19.

8. Click Finish. The wizard closes and the new project opens, ready for coding.

When you click Finish in the wizard, theConfiguration.xml segment file is created and
added to the project. Update andmodify the configuration segment file as required. For more
information about using the segment file, see "Copying Configuration Information Generated by
the UFT Custom Server Settings Wizard" on page 73.)
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Implementing Test Record for a Custom Control Using a
.NET DLL

Recording a business component or test on a control means listening to the activity of that control,
translating that activity into test object method calls, and writing themethod calls to the test.
Listening to the activities on the control is done by listening to control events, by hookingWindows
messages, or both.

Note: If you plan to create GUI tests using keyword-driven testing, and not by recording steps
on an application, you do not need to implement Test Record.

Write the code for Test Record by implementing themethods in the code segment created by the
wizard based on the IRecord interface (provided with the UFT .NET Add-in Extensibility SDK).
Your Test Record implementation does not inherit from the existing test object to which the custom
control is mapped. It replaces the existing object's Test Record implementation entirely. Therefore,
if you need any of the existing object's functionality, code it explicitly.

Before reading this section, make sure you are familiar with "Create Custom Servers" on page 19.

This section describes:

l "Implementing the IRecord Interface" below

l "Implementing Test Record for a Custom Control Using a .NET DLL" above

For more information on the interfaces, classes, enumerations, andmethods in this section, see the
UFT .NET Add-in Extensibility API Reference (available in the UFT .NET Add-in Extensibility
online Help.)

Implementing the IRecord Interface

To implement the IRecord interface, override the callback methods described below and add the
details of your implementation in your event handlers or message handler.

The examples provided below for each callback method are written in C#.

InitEventListener Callback Method
CustomServerBase. InitEventListener is called by UFT when your Custom Server is loaded. Add
your event andmessage handlers using this method.
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To add event and message handlers:

1. Implement handlers for the control's events.

A typical handler captures the event and writes amethod to the test. This is an example of a
simple event handler:

public void OnMouseDown(object sender, MouseEventArgs e)
{
    // If a button other than the left was clicked, do nothing.
    if(e.Button != System.Windows.Forms.MouseButtons.Left)
    return;
    /*
    For more complex events, here you would get any
    other information you need from the control.
    */
    // Write the test object method to the test
    RecordFunction("MouseDown",
    RecordingMode.RECORD_SEND_LINE,
    e.X,e.Y);
}

Formore information, see "Implementing Test Record for a Custom Control Using a .NET
DLL" on the previous page.

2. Add your event handlers in InitEventListener:

public override void InitEventListener()
{
    .....
    // Adding OnMouseDown handler.
    Delegate e = new MouseEventHandler(this.OnMouseDown);
    AddHandler("MouseDown", e);
    .....
}

Note that if the Test Record implementation will run in the context of the application being
tested, you can use the following syntax:

SourceControl.MouseDown += e;

If you use this syntax, youmust release the handler inReleaseEventListener.

3. Add a remote event listener.
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If your Custom Server will run in the UFT context, use a remote event listener to handle
events. Implement a remote listener of typeEventListenerBase that handles the events, and
add a call to AddRemoteEventListener in method InitEventListener.

public class EventsListenerAssist : EventsListenerBase
{ 
    // class implementation.
}
public override void InitEventListener()
{
    ...
    AddRemoteEventListener(typeof(EventsListenerAssist));
    ...
}

When you implement a remote event listener, youmust override
EventListenerBase.InitEventListener andEventListenerBase.ReleaseEventListener in
addition to overriding these callback functions inCustomServerBase. The use of these
EventListenerBase callbacks is the same as for theCustomServerBase callbacks. For
details, see theEventsListenerBase class in theUFT .NET Add-in Extensibility API
Reference.

When you handle events from the UFT context, the event arguments must be serialized. For
details, see CustomServerBase.AddHandler(String, Delegate, Type) and the
IEventArgsHelper interface in theUFT .NET Add-in Extensibility API Reference.

To avoid the complications of remote event listeners, run your event handlers in the
Application under test context, as described above.

OnMessage Callback Method
OnMessage is called on any window message hooked by UFT. If Test Record will run in the UFT
context andmessage handling is required, implement themessage handling in this method.

If Test Record will run in theApplication under test context, do not override this function.

For details, seeCustomServerBase.OnMessage in theUFT .NET Add-in Extensibility API
Reference.

GetWndMessageFilter Callback Method
If Test Record will run in the UFT context and listen to windows messages, override this method to
inform UFT whether the Custom Server will handle only messages intended for the specific custom
object, or whether it will handlemessages from child objects, as well.

For details, see IRecord.GetWndMessageFilter in theUFT .NET Add-in ExtensibilityAPI
Reference.

See also:"Troubleshooting and Limitations - Running the Support You Designed" on page 68.
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ReleaseEventListener Callback Method
UFT calls this method at the end of the recording session. InReleaseEventListener, unsubscribe
from all the events to which the Custom Server was listening. For example, if you subscribe to
OnClick in InitEventListenerwith this syntax,

SourceControl.Click += new EventHandler(this.OnClick);

youmust release it:

public override void ReleaseEventListener()
{
    ....
    SourceControl.Click -= new EventHandler(this.OnClick);
    ....
}

However, if you subscribe to the event with theAddHandlermethod, UFT unsubscribes
automatically.

Writing Test Object Methods to the Test

When information about activities of the control is received, whether in the form of events,
Windows messages, or a combination of both, this informationmust be processed as appropriate
for the application and a stepmust be written as a test object method call.

To write a test step, use theRecordFunctionmethod of theCustomServerBase class or the
EventsListenerBase, as appropriate.

Sometimes, it is impossible to know how an activity should be processed until the next activity
occurs. Therefore, there is amechanism for storing a step and deciding in the subsequent call to
RecordFunction whether to write it to the test. For details, seeRecordingMode Enumeration in
theUFT .NET Add-in ExtensibilityAPI Reference.

To determine the argument values for the test object method call, it may be necessary to retrieve
information from the control that is not available in the event arguments orWindows message. If the
Custom Server Test Record implementation is running in the context of the application being
tested, use theSourceControl property of theCustomServerBase class to obtain direct access
to the public members of the control. If the control is not thread-safe, use theControlGetProperty
method to retrieve control state information.
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Implementing Test Run for a Custom Control Using the
.NET DLL

Defining test object methods for Test Runmeans specifying the actions to perform on the custom
control when themethod is run in a step. Typically, the implementation of a test object method
performs several of the following actions:

l Sets the values of attributes of the custom control

l Calls amethod of the custom control

l Makes mouse and keyboard simulation calls

l Reports a step outcome to UFT

l Reports an error to UFT

l Makes calls to another library (to show amessage box, write custom log, and so on)

Define custom Test Runmethods if you are overriding existingmethods of the existing test object,
or if you are extending the existing test object by adding new methods.

Ensure that all test object methods recorded are implemented in Test Run, either by the existing
test object or by this Custom Server.

To define custom Test Runmethods, define an interface and instruct UFT to identify it as the Test
Run interface by applying theReplayInterface attribute to it. Only one replay interface can be
implemented in a Custom Server. If your interface defines methods with the same names as
existingmethods of the existing object, the interfacemethods override the test object
implementation. Any method name that is different from existing object's method name is added as
a new method.

Start a test object method implementation with a call toPrepareForReplay, specify the activities
to perform, and end with a call toReplayReportStep and/orReplayThrowError.

For more information, see theUFT .NET Add-in Extensibility API Reference (available in the UFT
.NET Add-in Extensibility).

Implementing Support for Table Checkpoints and Output
Values in the .NET DLL Custom Server

By adding table checkpoints to a test, UFT users can check the content and properties of tables
displayed in their application. By adding table output value steps to a test, you can retrieve values
from a table, store them, and then use them as input at a different stage in the run session.

With .NET Add-in Extensibility, you can enable UFT to support table checkpoints and output values
for custom table (grid) controls.

To implement table checkpoint and output value support, add a verification class in your Custom
Server that inherits from theVerificationServerBase class and override the necessary methods
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(for more information, see below). In the .NET Add-in Extensibility configuration file, map each
custom table control to anSwfTable test object, and to the verification class in the relevant Custom
Server. For information on the syntax of the verification class methods, see theUFT .NET Add-in
Extensibility API Reference (available with the .NET Add-in Extensibility SDK online Help).

Note:When creating a Custom Server using the UFT Custom Server Settings wizard, the
source code created by the wizard does not include commented code for table checkpoint and
output value support. Add the implementationmanually.

To implement support for table checkpoints and output values on custom table objects:

1. Map the custom table control to theSwfTable test object class. This instructs UFT to use an
SwfTable test object to represent the custom table control in GUI tests or components.

In the .NET Add-in Extensibility configuration file, <UFT Installation
folder>\dat\SwfConfig.xml, create aControl element with a Type attribute set to the name
of the custom table control, and theMappedTo attribute set toSwfTable.

For more information on theSwfConfig.xml file, see "Understanding How to Configure UFT
Windows Forms Extensibility" on page 71 and the .NET Add-in Extensibility Configuration
SchemaHelp (available with the .NET Add-in Extensibility SDK online Help).

2. Specify table verification configuration information for the Custom Server of this custom table
control.

In the sameSwfConfig.xml file, define aCustomVerify element. In this element, specify:

n The run-time context, which for this element must always beAUT.

n The name of the Custom Server (DLL) that contains the implementation of table checkpoint
and output value support for this control.

n The type name for the verification class within the Custom Server (DLL) including wrapping
namespaces.

A sample of theCustomVerify element is provided below:

<Control Type="System.Windows.Forms.DataGridView" MappedTo="SwfTable">
        <CustomRecord>
        ...
        ...
        </CustomRecord>
        <CustomReplay>
        ...
        ...
        </CustomReplay>
        <CustomVerify>
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        <Context>AUT</Context>
        <DllName>C:\MyProducts\Bin\\VfySrv.dll</DllName>
        <TypeName>VfySrv.DataGridCPSrv</TypeName>

        </CustomVerify>
        <Settings>
</Control>

3. In the verification class, override the following protectedmethods so that UFT receives what it
requires when supporting table checkpoints and output values.

n GetTableData

UFT calls this method to retrieve table data from the specified range of rows and returns the
data as an array of objects.

When working with a table checkpoint or output value, UFT calls theGetTableRowRange
method before this method so that the first and last rows in the data range of the table are
known to theGetTableDatamethod.

n GetTableRowRange

UFT calls this method to retrieve the number and range of rows in the table that will be
included in the checkpoint or output value.

When working with a table checkpoint or output value, UFT calls this method before the
GetTableDatamethod. TheGetTableRowRangemethod initializes the values of the first
and last rows in the data range of the table, which theGetTableDatamethod uses as input.

n GetTableColNames

UFT calls this method to retrieve the column names as an array of strings. UFT displays
these column names in the Table Checkpoint Properties and Table Output Value Properties
dialog boxes. If this method is not implemented, numbers appear instead of column names
in these dialog boxes.
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The images below shows what the Table Checkpoint Properties dialog box looks
like with and without GetTableColNames implementation:

The following sample (written in C#) demonstrates implementation of the GetTableData,
GetTableColNames, and GetTableRowRange methods.

using System;
using System.Collections.Generic;
using System.Text;
using Mercury.QTP.CustomServer;
using System.Windows.Forms;
namespace VfySrv
{

public class DataGridCPSrv : VerificationServerBase
{
/// GetTableData() is called by UFT to retrieve the data in a table.
/// The following base class properties are used:
/// SourceControl - Reference to the grid (table) object
/// FirstRow - The (zero-based) row number of the start of
/// the checkpoint or output value
/// LastRow - The (zero-based) row number of the end of
/// the checkpoint or output value
/// Returns a two-dimensional array of objects.
protected override object[,] GetTableData()
{

DataGridView GridView = (DataGridView)(base.SourceControl);
int TotalRows = GridView.Rows.Count;
int TotalColumns = GridView.Columns.Count;
int FirstRowN = base.FirstRow;
int LastRowN = base.LastRow;
TotalRows = LastRowN - FirstRown + 1;
object[,] Data = new object[TotalRows, TotalColumns];
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DataGridViewRowCollection Rows = GridView.Rows;
for (int i = FirstRowN; i <= LastRowN; i++)
{
DataGridViewRow Row = Rows[i];
DataGridViewCellCollection Cells = Row.Cells;
for (int k = 0; k < TotalColumns; k++)
{
Data[i - FirstRown, k] = Cells[k].Value;

}
}

return Data;
}

/// GetTableColNames is called by UFT to
/// retrieve the column names of the table.
/// Returns an array of column names.
protected override string[] GetTableColNames()
{

DataGridView GridView = (DataGridView)(this.SourceControl);
int TotalColumns = GridView.Columns.Count;
string[] ColNames = new string[TotalColumns];
for (int i = 0; i < TotalColumns; i++)
{

ColNames[i] = GridView.Columns[i].HeaderText;
}

return ColNames;
}

/// GetTableRowRange is called by UFT to
/// obtain the number of rows in the table.
protected override void GetTableRowRange

(out int FirstVisible, out int LastVisible, out int Total)
{

DataGridView GridView = (DataGridView)(this.SourceControl);
DataGridViewRowCollection Rows = GridView.Rows;
FirstVisible = -1;
LastVisible = Rows.Count -1;
for (int i = 0; i < Rows.Count; i++)
{

if (Rows[i].Visible == false)
continue;

FirstVisible = i;
break;

}
for (int i = FirstVisible + 1; i < Rows.Count; i++)
{

if (Rows[i].Visible)
continue;
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LastVisible = i;
break;

}
FirstVisible++;
LastVisible++;
Total = GridView.Rows.Count;

}
}

}

Running Code under Application Under Test from the
UFT Context

When the Custom Server is running in theUFT context, there is no direct access to the control,
which is in a different run-time process. To access the control directly, run part of the code in the
Application under test context. This is done using assistant classes.

To launch code from the UFT context that will run under theApplication under test context,
implement an assistant class that inherits from CustomAssistantBase. To create an instance of
an assistant class, call CreateRemoteObject. Before using the object, attach it to the control with
SetTargetControl.

AfterSetTargetControl is called, you can call methods of the assistant in one of the following
ways:

l If themethod can run in any thread of theApplication under test process, read and set control
values and call control methods with the simple obj.Member syntax:

int i = oMyAssistant.Add(1,2);

l If themethodmust run in the control's thread, use the InvokeAssistantmethod:

int i = (int)InvokeAssistant(oMyAssistant, "Add", 1, 2);

Tip: You can use the EventListenerBase, which is an assistant class that supports listening
to control events.

Reviewing Commonly-used API Calls
This section provides a quick reference of themost commonly used API calls. Review this
information before starting to implement methods.

Thesemethods are in CustomServerBase except where indicated.
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Formore information, see theUFT .NET Add-in Extensibility API Reference (available in the UFT
.NET Add-in Extensibility online Help.)

Test Record Methods

AddHandler Adds an event handler as the first handler of the event.

RecordFunction Records a step in the test.

Test Record Callback Methods

GetWndMessageFilter Called by UFT to set theWindows message filter.

InitEventListener Called by UFT to load event handlers and start listening for events.

OnMessage Called when UFT hooks the window message.

ReleaseEventListener Stops listening for events.

Test Run Methods

DragAndDrop, KeyDown, KeyUp, MouseClick,
MouseDblClick, MouseDown, MouseMove, MouseUp,
PressKey, PressNKeys, SendKeys, SendString

Mouse and keyboard
simulationmethods.

PrepareForReplay Prepares the control for an
action run.

ReplayReportStep Writes an event to the test
report.

ReplayThrowError Generates an error message
and changes the reported step
status.

ShowError Displays the .NET warning
icon.

TestObjectInvokeMethod Invokes one of themethods
exposed by the test object's
IDispatch interface.

Cross-Process Methods

AddRemoteEventListener Creates anEventListener instance in theApplication under test
process.

CreateRemoteObject Creates an instance of an assistant object in theApplication
under test process.

GetEventArgs
(IEventArgsHelper)

Retrieves and deserializes theEventArgs object.

Developer Guide
Chapter 4: Developing Your Support Set

HP UFT .NET Add-in Extensibility (11.50) Page 64 of 100



Init (IEventArgsHelper) Initializes theEventArguments helper class with anEventArgs
object.

InvokeAssistant Invokes amethod of aCustomAssistantBase class in the
control's thread.

InvokeCustomServer
(EventsListenerBase)

Invokes the Custom Server's methods running in theUFT process
from theApplication under test process.

SetTargetControl
(CustomAssistantBase)

Attaches to the source custom control by the control's window
handle.

General Methods

ControlGetProperty Retrieves a property of a control that is not thread-safe.

ControlInvokeMethod Invokes amethod of a control that is not thread-safe.

ControlSetProperty Sets a property of a control that is not thread-safe.

GetSettingsValue Gets a parameter value from the settings of this control in the
configuration file.

GetSettingsXML Returns the settings of this control as entered in the configuration file.

Table Checkpoint and Output Value Support Methods

GetTableData (VerificationServerBase) Called by UFT to retrieve the data in a table.

GetTableRowRange
(VerificationServerBase)

Called by UFT to retrieve the first and last rows of the
table.

GetTableColNames
(VerificationServerBase)

Called by UFT to retrieve the names of the table
columns.

Using XML Files to Extend Support for a Custom
Control

You can implement custom control support without programming a .NET DLL by entering the
appropriate Test Record and Test Run instructions for that custom control in a control definition file.
(Create a separate control definition file for each control you want to customize.) You can instruct
UFT to load the custom control implementation instructions by specifying each control definition file
in the .NET Add-in Extensibility configuration file, SwfConfig.xml.

Note:When extending support using an XML file, UFT generates an ad hoc .NET DLL for you
based on the XML file. This ad hoc .NET DLL becomes the custom server for the control.

When using this technique, you do not have the support of the .NET development environment—
the object browser and the debugger— or the ability to create table checkpoints or output values.
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However, by enabling the implementation of custom control support without the .NET development
environment, this technique enables relatively rapid implementation, even in the field.

This feature is most practical either with relatively simple, well documented controls, or with
controls that map well to an existing object but for which you need to replace the Test Record
definitions, or replace or add a small number of test object Test Runmethods.

Understanding Control Definition Files
The control definition file can contain aRecord element in which you define the customized
recording for the control and aReplay element in which you define the customized test object
methods.

l TheRecord element specifies the control events for which you want UFT to add steps to the
test (or component) during a recording session. The steps are calls to test object methods of the
custom control's test object.

l TheReplay element specifies the operations that UFT should perform on the control for each
test object method during a run session.

You do not always need to enter both aRecord and aReplay element:

l If the Test Record implementation for the custom test object should be different than the one
defined for the existing test object, create aRecord element in the control definition file for the
custom control.

l Similarly, if the Test Run implementation for the custom test object should be different than the
one defined for the existing test object, create aReplay element in the control definition file for
the custom control.

If you create aRecord element, the definitions replace the Test Record implementation of the
existing test object entirely. If you create aReplay element, it inherits the Test Run implementation
of the existing object and extends it. For more information on test object mapping options, see "Map
the Custom Controls to the Relevant Test Objects " on page 20.

For information on the elements in a control definition XML file, see the .NET Add-in Extensibility
Control Definition SchemaHelp (available with the .NET Add-in Extensibility SDK online Help).

An Example of a Control Definition File
The following example shows the handling of an object whose value changes at eachMouseUp
event. The value is in theValue property of the object. TheMouseUp event handler has Button,
Clicks, Delta, X, and Y event arguments.

TheRecord element describes the conversion of theMouseUp event to aSetValue command.
TheReplay element defines theSetValue command as setting the value of the object to the
recorded Value and displaying the position of themouse pointer for debugging purposes:

<?xml version="1.0" encoding="UTF-8"?>
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<Customization>
    <Record>
        <Events>
            <Event name="MouseUp" enabled="true">
                <RecordedCommand name="SetValue">
                    <Parameter>
                        Sender.Value
                    </Parameter>
                    <Parameter lang="C#">
                        String xy;
                        xy = EventArgs.X + ";" + EventArgs.Y;
                        Parameter = xy;
                    </Parameter>
                </RecordedCommand>
            </Event>
        </Events>
    </Record>
    <Replay>
        <Methods>
            <Method name="SetValue">
                <Parameters>
                    <Parameter type="int" name="Value"/>
                    <Parameter type="String" name="MousePosition"/>
                </Parameters>
                <MethodBody>
                    RtObject.Value = Value;
                    System.Windows.Forms.MessageBox.Show(MousePosition, "Mou
se Position at Record Time");
                </MethodBody>
            </Method>
        </Methods>
    </Replay>
</Customization>

Using the .NET Add-in Extensibility Samples
The .NET Add-in Extensibility SDK provides a sample support set to help you learn about .NET
Add-in Extensibility. The toolkit support set files are installed in the <UFT .NET Add-in
Extensibility SDK installation folder>\samples\WinFormsExtSample folder. You can study
the content of these files to gain a better understanding of how to develop your own toolkit support
sets.

The sample support set extends UFT support for the SandBar custom .NETWindows Forms
control. The custom server provided in this sample is similar to the one you create in "Learning to
Create Support for a Complex Custom .NETWindows Forms Control" on page 90.
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TheSandbarSample.sln solution file located in theWinFormsExtSample folder includes a
configuration file and a fully implemented custom server that supports the SandBar control. The
SandBarCustomServer implementation is provided in C# and in Visual Basic, in separate projects
within the solution (SandbarCustomServer andVBSandbarCustomServer). In addition, the
SandbarSample solution includes a sample .NETWindows Forms application that uses the
SandBar toolbar control (SandbarTestApp).

To learn how extensibility can affect UFT's interaction with custom controls, create and run a UFT
GUI test on the sample application before and after deploying the sample toolkit support set to UFT.

Considerations for Working with the SandBar Support Sample

l To open the SandbarSample solution, useMicrosoft Visual Studio 2005 or later.

l Before you build the SandbarSample solution, ensure that the following items are installed on
your computer:

n The UFT .NET Add-in Extensibility SDK

n SandBar for .NET 2.0/3.x (can be downloaded from
http://www.divil.co.uk/net/download.aspx?product=2&license=5)

l After successfully building the SandbarSample solution, deploy the C# or Visual Basic custom
server it creates as described in "Configuring and Deploying the Support Set" on page 70.

l Before you update theSwfConfig.xml file according to the information inConfiguration.xml,
consider the following: TheConfiguration.xml file in the SandbarSample solution is set up to
use the DLL generated by the C# project and located in <UFT .NET Add-in Extensibility
installation folder>\samples\
WinFormsExtSample\Bin.

n To useVBCustomSandBarSrv.dll, replace all appearances of SandbarCustomServer in
with VBCustomSandBarSrv.dll.

n If your DLL file is located in a different location, update the path in theDllName element
accordingly.

Troubleshooting and Limitations - Running the
Support You Designed

This section describes troubleshooting and limitations for developing your support set.

The custom server is not receiving some Windows messages
During a recording session, the custom server mapped to your custom control is only created after
some operation takes place on the custom control itself.

If you design theGetWndMessageFiltermethod to specify that your custom server will handle
messages that occur on other controls, suchmessages can only be handled after the custom
server is created.
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Therefore, for example, youmay have to click on the custom control before the custom server can
receive and process messages on other controls in the application.

Depending on how you implement support for recording on your custom control, youmight want to
provide instructions regarding this issue to the UFT users who use your support set.

A General Run Error occurs while running the test in UFT
When using the .NET Add-in Extensibility API with Microsoft .NET Framework 1.1, aGeneral Run
Errormay occur while running your test. This is caused by anExecution Engine Exception error
in the application under test (AUT).

Workaround: Install Service Pack 1 (or later) for Microsoft .NET Framework 1.1.

A run-time error occurs while running the test in UFT
When using an XML-based Custom Server, if you havemore than one version of Microsoft .NET
Framework installed, a run-time error might occur during the run session. The error message in the
log file indicates that the configuration file contains a compilation error. This is because assemblies
compiled with Microsoft .NET Framework version 2.0 and later are not recognized by earlier
versions of Microsoft .NET Framework.

Workaround:Perform one of the following:

l Solution 1: In the Registry, in the following key HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\.NETFrameworkadd the following DWORD Value
"OnlyUseLatestCLR"=dword:00000001

l Solution 2: If the .NET application you are testing has a configuration file, add the following
information to the file:

<configuration>
<startup>

<supportedRuntime version="v2.0.50727"/>
</startup>

</configuration>

The configuration file must be named <executable_name>.exe.Config and be located in the
same folder as the executable of the .NET application you are testing.
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Chapter 5: Configuring and Deploying the
Support Set

After developing the implementation for your Custom Server, the UFT .NET Add-in Extensibility
Support Set is ready for configuration and deployment.

This chapter includes:

Understanding the Deployment Workflow 71

Configuring UFT to Use the Custom Server 71

Understanding How to Configure UFTWindows Forms Extensibility 71

Copying Configuration Information Generated by the UFT Custom Server Settings Wizard 73

Deploying the Custom Support Set 76

Placing Files in the Correct Locations 76

Modifying Deployed Support 77

Removing Deployed Support 77

Testing the Custom Support Set 77

Testing Basic Functionality of the Support Set 77

Testing Implementation 79
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Understanding the Deployment Workflow
The workflow for deploying a .NET Add-in Extensibility support set consists of the stages shown in
the highlighted area of the image. These stages are described in detail in the sections below.

Configuring UFT to Use the Custom Server
The .NET Add-in Extensibility configuration file (SwfConfig.xml) provides UFT with the
configuration information it needs to load your Custom Servers.

Understanding How to Configure UFT Windows Forms
Extensibility

To instruct UFT to load Custom Servers according to the appropriate configuration, enter the
information in the .NET Add-in Extensibility configuration file. This file, SwfConfig.xml, is located
in the <UFT installation folder>\dat folder.
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Enter configuration information into theSwfConfig.xml file in one of the following ways:

l Manually edit the file using any text editor.

l Copy information from configuration.xml files generated by the UFT Custom Server Settings
wizard.

For more information about the wizard, see "Using a .NET DLL to Extend Support for a Custom
Control" on page 47.

For instructions on how to copy information from configuration.xml files, see "Copying
Configuration Information Generated by the UFT Custom Server Settings Wizard" on the next
page.

When configuring UFTWindows Forms extensibility, define elements according to the coding
option you selected for implementing your Custom Server:

l "When Using a .NET DLLCustom Server" below

l "When Using an XMLCustom Server" on the next page

When Using a .NET DLL Custom Server
In theSwfConfig.xml file, for each custom .NET control that you will implement using a .NET DLL
Custom Server, you can define:

l AMappedTo attribute, if you want the custom control to correspond to a test object other than
the default generic test object SwfObject.

l A CustomRecord element if you want to customize recording on the control.

l A CustomReplay element if you want to customize how test steps are run on a custom control.

l A CustomVerify element if you want to add table checkpoint and output value support for
custom table controls.

l A Settings element, in which you can use theParameter element to pass values to the Custom
Server at run-time.
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When Using an XML Custom Server
In theSwfConfig.xml file, for each custom .NET control that you will implement using an XML
Custom Server, you define:

l AMappedTo attribute, if you want the custom control to correspond to a test object other than
the default test grid object SwfTable.

l TheContext attribute of aCustomRecord element if you want to customize recording on the
control.

l TheContext attribute of aCustomReplay element if you want to customize how test steps are
run on a custom control.

l A Settings element, in which you can use theParameter element to pass values to the Custom
Server at run-time.

Note: UFT loads the Custom Server when you open a test. Therefore, if you implement your
Custom Server as a .NET DLL, any changes youmake to the DLL after the Custom Server is
loaded take effect only the next time you open a test.

For information on the elements in the .NET Add-in Extensibility configuration file
(SwfConfig.xml), see the .NET Add-in Extensibility Configuration SchemaHelp (available with the
.NET Add-in Extensibility SDK online Help).

Copying Configuration Information Generated by the
UFT Custom Server Settings Wizard

When running the UFT Custom Server Settings wizard to create a Custom Server, the wizard
creates an XML configuration segment. The wizard outputs this segment to help you enter the
configuration information in the .NET Add-in Extensibility configuration file.

To incorporate the contents of the XML configuration segment before deploying the Custom Server:

1. Edit theConfiguration.xml segment file in the project to ensure that the information is correct.
Set theDllName element value to the location to which you will deploy the Custom Server. If
Test Record and/or Test Run are to be loaded in different run-time contexts, edit theContext
value accordingly.

2. Copy the entire <Control>...</Control> node. Do not include the enclosing <Controls> tags.

3. Open the .NET Add-in Extensibility configuration file, <UFT installation
folder>\dat\SwfConfig.xml. Paste theControl node from Configuration.xml at the end of
the file, before the closing </Controls> tag.
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4. Save the file. If UFT was open, youmust close and reopen it for theSwfConfig.xml changes
to take effect.

Note: You can validate the configuration file you design against the <UFT installation
folder>\dat\SwfConfig.xsd file.

Example of a .NET Add-in Extensibility Configuration File
Following is an example of a file that configures UFT to recognize the following controls:

l Support for theMyCompany.WinControls.MyListView control is implemented in the
CustomMyListView.CustListView .NET DLLCustom Server. The Custom Server is not
installed in the GAC, so the DLL name is specified as a path and file name (and is not passed as
a type name according to GAC standard syntax).

MyListView is mapped to theSwfListView test object, and runs in the context of the application
being tested.

l Support for themySmileyControls.SmileyControl2 control is implemented in an XML file.
Therefore, the path and file name for the Control Definition file that contains its implementation is
passed to UFT during run-time using theParameter element.

TheSmileyControl2 control is not explicitly mapped to any test object in theSwfConfig.xml
file, so UFTmaps it to the default generic test object, SwfObject.

l Customized record and run support for theSystem.Windows.Forms.DataGridView control is
implemented in a .NET DLLCustom Server calledCustomMyTable.dll. Table checkpoint and
output value support for theSystem.Windows.Forms.DataGridView control is implemented in
a .NET DLLCustom Server calledVfySrv.dll.

DataGridViewmust bemapped to theSwfTable test object (according to the restrictions
imposed by the TableElement complex type element in the schema), and, because the
customized support includes table checkpoints and output values, must run in the context of the
application being tested.

<?xml version="1.0" encoding="UTF-8"?>
<Controls>

<Control Type="MyCompany.WinControls.MyListView" MappedTo="SwfListView" >
<CustomRecord>

<Component>
<Context>AUT</Context>
<DllName>C:\MyProducts\Bin\CustomMyList View.dll</DllName>
<TypeName>CustomMyListView.CustListView</TypeName>

</Component>
</CustomRecord>
<CustomReplay>

<Component>
<Context>AUT</Context>
<DllName>C:\MyProducts\Bin\CustomMyList View.dll</DllName>
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<TypeName>CustomMyListView.CustListView</TypeName>
</Component>

</CustomReplay>
<Settings>

<Parameter Name="sample name">sample value</Parameter>
<Parameter Name="ConfigPath">C:\Program Files\HP\Unified Functional Testing\dat\Ext

ensibility\dotNET\MyContrSIM.xml</Parameter>
</Settings>

</Control>

<Control Type="mySmileyControls.SmileyControl2">
<Settings>

<Parameter Name="ConfigPath">d:\UFT\bin\ConfigSmiley.xml
</Parameter>

</Settings>
<CustomRecord>

<Component>
<Context>AUT-XML</Context>

</Component>
</CustomRecord>
<CustomReplay>

<Component>
<Context>AUT-XML</Context>

</Component>
</CustomReplay>

</Control>

<Control Type="System.Windows.Forms.DataGridView"
MappedTo="SwfTable">

<CustomRecord>
<Component>

<Context>QTP</Context>
<DllName>C:\MyProducts\Bin\CustomMyTable.dll</DllName>
<TypeName>CustomMyTable.CustTableView</TypeName>

</Component>
</CustomRecord>
<CustomReplay>

<Component>
<Context>AUT-XML</Context>

</Component>
</CustomReplay>
<CustomVerify>

<Context>AUT</Context>
<DllName>C:\MyProducts\Bin\VfySrv.dll</DllName>
<TypeName>VfySrv.DataGridCPSrv</TypeName>

</CustomVerify>
<Settings>

<Parameter Name="sample name">sample value</Parameter>
</Settings>

</Control>

</Controls>
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Deploying the Custom Support Set
The next stage of extending UFT GUI testing support for custom controls is deployment. This
means placing all files you created in the correct locations, so that the custom support is available
to UFT.

After you deploy the custom support, if you run an application that contains the custom controls and
perform UFT operations on the application, you can see the effects of the support you designed.

Placing Files in the Correct Locations
To deploy the support set that you create, place the files in the locations described in the following
table. Make sure that UFT is closed before placing the files in their appropriate locations.

File Name Location

SwfConfig.xml <UFT installation path>\dat

<Test Object Configuration File
Name>.xml

Note: You can havemore than one test
object configuration file (if any), and
name them as you wish.

l <UFT installation
path>\dat\Extensibility\DotNet

l <UFT Add-in for ALM
Installation Path>\dat\Extensibility\DotNet

(Optional. Required only if UFT Add-in for
ALM is installed)

<Control Definition File Name>.xml>

Note: The Control Definition file is used
when creating a Custom Server using
the XML coding option. You can have
more than one control definition file (one
for each custom control).

l <UFT installation
path>\dat\Extensibility\DotNet

l <UFT Add-in for ALM
Installation Path>\dat\Extensibility\DotNet\

(Optional. Required only if UFT Add-in for
ALM is installed)

<Custom Server File Name>.dll

Note: This type of Custom Server is
used when creating a Custom Server
using the .NET DLL coding option. You
can havemore than one custom server
for each custom control.

Specify the location of your compiled Custom
Servers (DLLs) in theSwfConfig.xml file.
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Modifying Deployed Support
If youmodify a support set that was previously deployed to UFT, the actions youmust perform
depend on the type of change youmake, as follows:

l If youmodify the .NET Add-in Extensibility configuration file or a test object configuration file,
youmust deploy the support.

l If youmodify a test object configuration file, youmust reopen UFT and open aGUI test after
deploying the support.

Removing Deployed Support
To remove support for a custom control from UFT after it is deployed, youmust delete the
corresponding section in theSwfConfig.xml file from <UFT installation path>\dat and remove
the corresponding test object configuration file from <UFT installation
path>\dat\Extensibility\DotNet.

If you remove support for a new test object method that you added in a test object configuration file,
you should remove themethod definition (or the whole file, if appropriate) so that UFT users do not
create test steps that call that method. Modify or remove the test object configuration file in: <UFT
Installation Path>\Dat\Extensibility\DotNet (and <UFT Add-in for ALM
Installation Path>\Dat\Extensibility\DotNet if relevant).

Testing the Custom Support Set
We recommend that you test the custom support using an incremental approach. First, test the
basic functionality of the support set. Then, test its implementation.

l "Testing Basic Functionality of the Support Set" below

l " Testing Implementation" on page 79

Testing Basic Functionality of the Support Set
After you define a basic .NETWindows Forms configuration file enabling UFT to identify which test
object classes to use for the different controls, and (optionally) define your test object model in the
test object configuration file, you can test the existing functionality of the support set. To do this,
you deploy the support set and test how UFT interacts with the controls in your environment.

To test your support set after defining the test object classes and mapping them to custom
.NET Windows Forms controls:

1. In the test object configuration file, set the TypeInformation\DevelopmentMode attribute to
true, to ensure that UFT reads all of the test object class information from the file each time it
opens. When you complete the development of the support set, make sure to set this attribute
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to false.

2. Deploy the support set on a UFT computer by copying the files of the support set to the correct
locations in the UFT installation folder, as described in "Placing Files in the Correct Locations"
on page 76.

3. Open UFT, load the .NET Add-in, and open aGUI test. (If the Add-in Manager dialog box does
not open when you open UFT, see theHP Unified Functional Testing Add-ins Guide for
instructions.)

4. Open an application with your custom controls.

5. Based on themapping definitions you created, UFT can already recognize and learn your
controls.

Use theAdd Objects to Local button in the Object Repository dialog box to learn your
controls.

6. If you created a test object configuration file, you can already see its effect on UFT:

a. If you added a test object method to a test object class, you can view it using the Object

Spy .

b. You can create test steps that use the test object method that you added. (If you have not
yet implemented the custom server that supports this test object method, running a such a
test step will cause a run-time error.)

In the Keyword View:

Create a test step with a test object from a class that youmodified.

o If you added a test object method to a test object class, themethod appears in the list of
available operations in theOperation column.

o After you choose an operation, theValue cell is partitioned according to the number of
arguments of the selected operation, and if you defined possible values for the operation
(in the ListOfValues element), they are displayed in a list.

o The descriptions and documentation strings you defined for the test object methods are
displayed in tooltips and in theDocumentation column, respectively.

In the Editor:

Create a test step with a test object from a class that youmodified. The statement
completion feature displays all of the operations available for the test object, and possible
input values for these operations, if relevant, based on the definitions in the test object
configuration file.
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In the Step Generator:

Create a test step with a test object from a class that youmodified. The operations that you
defined in the test object configuration file are displayed in theOperation list, and the
descriptions you defined for the operations are displayed as tooltips.

Note: Formore information on working with these options in UFT, see theHP Unified
Functional Testing User Guide.

Testing Implementation
After you complete additional stages of developing support for your environment, you can deploy
the support set again and test additional areas of interaction between UFT and your controls (for
example, running and recording GUI tests).

To test your support set after developing support for additional UFT functionality:

1. Follow the steps in "Testing Basic Functionality of the Support Set" on page 77 to deploy the
support set, open UFT, load the support and run an application with controls from your
environment.

2. Depending on the UFT functionality for which you are developing support, perform the relevant
UFT operations on the application to test that support. For example, run a test on the
application, record test steps on the application and so on.
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Chapter 6: Learning to Create Support for a
Simple Custom .NET Windows Forms Control

In this tutorial, you will learn how to build a Custom Server for aMicrosoft TrackBar control that
enables UFT to record and run aSetValue operation on the control. You will implement the Custom
Server in C#. A Custom Server can be similarly implemented in Visual Basic.

This tutorial refers to Microsoft Visual Studio 2008. However, you can use other supported versions
of Visual Studio to build the Custom Server as described in this tutorial.

Note: TheMicrosoft Visual Studio dialog box images and the instructions in this chapter refer
to Microsoft Visual Studio 2008. If you use a different Microsoft Visual Studio version, the
dialog boxes may differ slightly in appearance and theUFT CustomServer templatemay be
located in a slightly different node in the tree.

This chapter includes:

Developing a New Support Set 81

Implementing Test Record Logic 84

Implementing Test Run Logic 85

Checking the TrackBarSrv.cs File 86

Configuring and Deploying the Support Set 87

Testing the Support Set 88
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Developing a New Support Set
The first step in creating support for a custom control is to create a new Custom Server project.
This project will create support for the TrackBar control.

To create a new Custom Server project:

1. OpenMicrosoft Visual Studio.

2. Select File > New > Project. The New Project dialog box opens.
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3. Specify the following settings:

n Select theVisual C# > Windows node in theProject types tree. (In Microsoft Visual
Studio versions other than 2008, theUFT CustomServer templatemay be located in a
slightly different node in the tree.)

n Select UFT CustomServer in the Templates pane.

n In theName box, specify the project name UFTCustServer.

n Accept the rest of the default settings.

4. Click OK. The UFT Custom Server Settings wizard opens.
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5. In the Application Settings page, specify the following settings:

n In theServer class name box, enter TrackBarSrv.

n Select theCustomize Record process check box.

n Select theCustomize Run process check box.

n Accept the rest of the default settings.

6. Click Next. The XMLConfiguration Settings page opens.

7. In the XMLConfiguration Settings page, specify the following settings:

n Make sure theAuto-generate the XML configuration segment check box is selected.

n In theCustomized Control type box, enter System.Windows.Forms.TrackBar.

n Accept the rest of the default settings.
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8. Click Finish. In the Class View window, you can see that the wizard created a TrackBarSrv
class derived from theCustomServerBase class and ITrackBarSrvReplay interface.

Implementing Test Record Logic
Youwill now implement the logic that records aSetValue(X) commandwhen aValueChanged
event occurs, using an event handler function.

To implement the Test Record logic:

1. In the TrackBarSrv class, locate an appropriate place to add a new method,
OnValueChanged. For example, youmight want to add it after other event handler methods,
such as OnMessage, in the IRecord override Methods region.

2. Add the new method with the following signature to the TrackBarSrv class:

public void OnValueChanged(object sender, EventArgs e) { }

Note: You can add the new methodmanually or use the wizard that Visual Studio provides
for addingmethods and functions to a class.

3. Add the following implementation to the function you just added (if copying and pasting,
remove the redundant line breaks):

public void OnValueChanged(object sender, EventArgs e)
{
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System.Windows.Forms.TrackBar trackBar = (System.Windows.Forms.TrackBar)
sender;
// get the new value
int newValue = trackBar.Value;
// Record SetValue command to the test
RecordFunction("SetValue", RecordingMode.RECORD_SEND_LINE, newValue);

}

4. Register the OnValueChanged event handler for the ValueChanged event, by adding the
following code to the InitEventListener method:

public override void InitEventListener()
{

Delegate e = new System.EventHandler(this.OnValueChanged);
AddHandler("ValueChanged", e);

}

Implementing Test Run Logic
Youwill now implement aSetValuemethod for the test Test Run.

To implement the Test Run logic:

1. Add the followingmethod definition to the ITrackBarSrvReplay interface:

[ReplayInterface]
public interface ITrackBarSrvReplay
{

void SetValue(int newValue);
}

2. Add the followingmethod implementation to the TrackBarSrv class in theReplay interface
implementation region (if copying and pasting, remove the redundant line breaks):

public void SetValue(int newValue)
{
System.Windows.Forms.TrackBar trackBar = (System.Windows.Forms.TrackBar)

SourceControl;
trackBar.Value = newValue;

}

3. Build your project.
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Checking the TrackBarSrv.cs File
Following is the full source code for the TrackBarSrv class. Check that the contents of your
TrackBarSrv.cs file is similar to the one illustrated below.

using System;
using Mercury.QTP.CustomServer;
namespace UFTCustServer
{

[ReplayInterface]
    public interface ITrackBarSrvReplay

{
        void SetValue(int newValue);
    }
    public class TrackBarSrv:
        CustomServerBase,
        ITrackBarSrvReplay

{
        public TrackBarSrv()

{
        }
        public override void InitEventListener()

{
            Delegate e = new System.EventHandler(this.OnValueChanged);
            AddHandler("ValueChanged", e);
        }
        public override void ReleaseEventListener()

{
        }
        public void OnValueChanged(object sender, EventArgs e)

{
            System.Windows.Forms.TrackBar trackBar =

(System.Windows.Forms.TrackBar)sender;
            int newValue = trackBar.Value;
            RecordFunction("SetValue",
                            RecordingMode.RECORD_SEND_LINE,
                            newValue);
        }
        public void SetValue(int newValue)

{
            System.Windows.Forms.TrackBar trackBar =

(System.Windows.Forms.TrackBar)SourceControl;
            trackBar.Value = newValue;
        }
    }
}
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Configuring and Deploying the Support Set
Now that you created the UFT Custom Server, you need to configure UFT to use this Custom
Server when recording and running GUI tests on the TrackBar control.

To configure UFT to use the Custom Server:

1. In the Solution Explorer window, double-click theConfiguration.XML file.

The following content should be displayed:

<!-- Merge this XML content into file "<UFT installation folder>\dat\SwfC
onfig.xml". -->
<Control Type="System.Windows.Forms.TrackBar">
    <CustomRecord>
        <Component>
            <Context>AUT</Context>
            <DllName>D:\Projects\UFTCustServer\Bin\UFTCustServer.dll</Dll
Name>
            <TypeName>UFTCustServer.TrackBarSrv</TypeName>
        </Component>
    </CustomRecord>
    <CustomReplay>
        <Component>
            <Context>AUT</Context>
            <DllName>D:\Projects\UFTCustServer\Bin\UFTCustServer.dll</Dll
Name>
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            <TypeName>UFTCustServer.TrackBarSrv</TypeName>
        </Component>
    </CustomReplay>
    <!--<Settings>

<Parameter Name="sample name">sample value</Parameter>
    </Settings> -->
</Control>

2. Select the <Control>...</Control> segment and select Edit > Copy from themenu.

3. Open theSwfConfig.xml file located in <UFT installation folder>\dat.

4. Paste the <Control>...</Control> segment you copied from Configuration.xml into
SwfConfig.xml, under the <Controls> tag inSwfConfig.xml. After you paste the segment,
the SwfConfig.xml file should look as follows:

<?xml version="1.0" encoding="UTF-8"?>
<Controls>
    <Control Type="System.Windows.Forms.TrackBar">
        <CustomRecord>
            <Component>
                <Context>AUT</Context>
                <DllName>D:\Projects\UFTCustServer\Bin\UFTCustServer.dll<
/DllName>
                <TypeName>UFTCustServer.TrackBarSrv</TypeName>
            </Component>
        </CustomRecord>
        <CustomReplay>
            <Component>
                <Context>AUT</Context>
                <DllName>D:\Projects\UFTCustServer\Bin\UFTCustServer.dll<
/DllName>
                <TypeName>UFTCustServer.TrackBarSrv</TypeName>
            </Component>
        </CustomReplay>
    </Control>
</Controls>

5. Make sure that the <DllName> elements contain the correct path to your Custom Server DLL.

6. Save theSwfConfig.xml file.

Testing the Support Set
You can now verify that UFT records and runs GUI tests as expected on the custom TrackBar
control by testing the Custom Server.
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To test the Custom Server:

1. Open UFT with the .NET Add-in loaded, and open aGUI test.

2. Start recording on a .NET application with aSystem.Windows.Forms.TrackBar control.

3. Click the TrackBar control. UFT should record commands such as:

SwfWindow("Form1").SwfObject("trackBar1").SetValue 2

4. Run the test. The TrackBar control should receive the correct values.
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Chapter 7: Learning to Create Support for a
Complex Custom .NET Windows Forms
Control

In this tutorial, you will learn how to build a Custom Server for controls that require more complex
implementation solutions, so that UFT can record and run operations on these controls. You will
implement the Custom Server in C#. A Custom Server can be similarly implemented in Visual
Basic.

The explanations in this chapter assume that you are familiar with .NET Add-in Extensibility
concepts and already know how to implement a Custom Server.

This chapter includes:

SandBar Toolbar Example 91

Understanding the ToolBarSrv.cs File 96
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SandBar Toolbar Example
This example demonstrates how to implement .NET Add-in Extensibility for the Divelements
Limited TD.SandBar.Toolbar control.

You can view the full source code of the final ToolBarSrv.cs class implementation in
"Understanding the ToolBarSrv.cs File" on page 96.

A complete support set for the SandBar control, implemented both in C# and in Visual Basic, is
located in <UFT .NET Add-in Extensibility SDK installation
folder>\samples\WinFormsExtSample. You can use the files in this sample as an additional
reference when performing this tutorial. For more information, see "Using the .NET Add-in
Extensibility Samples" on page 67.

Tip: You can download an evaluation copy of the TD.SandBar.Toolbar control from:
http://www.divil.co.uk/net/download.aspx?product=2&license=5.

The Toolbar control appears as follows:

The Toolbar control is comprised of a variety of objects, such as:

l ButtonItem objects, which represent buttons in the toolbar. ButtonItem objects contain images
and no text. EachButtonItem object has a unique tooltip.

l DropDownMenuItem objects, which represent drop-downmenus in the toolbar.

Both theButtonItem object and theDropDownMenuItem object are derived from the
ToolbarItemBase object.

When you implement a Custom Server for a custom control, you want UFT to support recording and
running the user's actions on the custom controls. When recording the test, your Custom Server
listens to the control's events and handles the events to perform certain actions to add steps to the
UFT GUI test. When running the test, you simulate (replay) the same actions the user performed on
that control.

For example, suppose you want to implement a user pressing a button on a custom toolbar. Before
doing so, youmust understand the toolbar control, its properties andmethods, and understand how
you can use them to implement the Custom Server.
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Following are some of the SandBar ToolBar object's properties and events (methods are not
visible in this image) as displayed in the Object Browser in Visual Studio:

As you can see in the image above, the ToolBar object has a property called Items that retrieves
the collection of ToolbarItemBase objects assigned to the ToolBar control. You can also see that
the ToolBar control has an event calledButtonClick. Your Custom Server can listen to the
ButtonClick event to know when a button in the toolbar is clicked. However, this event does not
indicate which specific button in the toolbar is clicked.
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Now expand theButtonItem object and review its properties, methods, and events:

As shown in the image above, theButtonItem object is derived from the ToolbarItemBase object.
You can see that the ToolbarItemBase object contains a ToolTipText property, but does not
contain aClick event or method.

When you look at the custom toolbar object, the following possible implementation issues arise:

1. When handling a ButtonClick event during recording, how can you tell
which button in the toolbar was clicked?
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Solution:All of the ToolBar object's events are ToolBarItemEventArgs events that are
derived from theEventArgs object:

The Item property indicates which toolbar item (button) raised the event. You can use that
toolbar item's unique ToolTipText property to recognize which button was clicked and add that
to the UFT GUI test.

To do this, enter the following code in theRecord events handlers section of the
ToolBarSrv.cs file:

#region Record events handlers
private void oControl_ButtonClick(object sender, TD.SandBar.ToolBarItemEv
entArgs e)
{
    TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
    // Add a step in the test for the test object with the
    // ClickButton method and the tooltip text as an argument
    base.RecordFunction("ClickButton", RecordingMode.RECORD_SEND_LINE, e.
Item.ToolTipText);
}
#endregion
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Now, each time you record a click on a button in the toolbar, a step is added to the test for the
toolbar test object with theClickButtonmethod and the tooltip text of the button as its
argument. For example:

SwfToolbar("MySandBar").ClickButton "Spelling and Grammar"

2. When running a test, how do you perform a ClickButton method, when
the ButtonItem object does not contain a Click method or event, and
you know only the ButtonItem object's tooltip text?
Solution: The ToolbarItemBase object has a property calledButtonBounds:

You can loop through all of the ToolbarItemBase objects until you find a ToolbarItemBase
objects that has the same tooltip text as theButtonItem object, find that ToolbarItemBase
object's rectangle boundaries, calculate themiddle of its boundaries, and click that point.

To do this, enter the following code in theReplay interface implementation section of the
ToolBarSrv.cs file:

#region Replay interface implementation
public void ClickButton(string text)
{
TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
    //Find the correct item in the toolbar according to
    // its tooltip text.
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    for(int i=0; i<oControl.Items.Count; i++)
{

        //Found the correct ButtonItem
        if(oControl.Items[i].ToolTipText == text)

{
            //Retrieve the rectangle of the button's boundaries
            // and locate its center
            System.Drawing.Rectangle oRect = oControl.Items[i].ButtonBoun
ds;
            int x = oRect.X + oRect.Width/2;
            int y = oRect.Y + oRect.Height/2;
            //Click the middle of the button item
            base.MouseClick(x, y, MOUSE_BUTTON.LEFT_MOUSE_BUTTON);
            break;
        }
    }
    //Add the step to the report
    base.ReplayReportStep("ClickButton", EventStatus.EVENTSTATUS_GENERAL,
text);
}
#endregion

Understanding the ToolBarSrv.cs File
Following is the full source code for the ToolBarSrv.cs class, used to implement UFT record and
run support for the TD.SandBar.Toolbar control:

using System;
using Mercury.QTP.CustomServer;
//using TD.SandBar;

namespace ToolBar
{

[ReplayInterface]
public interface IToolBarSrvReplay
{

void ClickButton(string text);
}
/// <summary>
/// Summary description for ToolBarSrv.
/// </summary>
public class ToolBarSrv:

CustomServerBase,
IToolBarSrvReplay

{
// You shouldn't call Base class methods/properties at the constructor
// since its services are not initialized yet.
public ToolBarSrv()
{
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//
// TODO: Add constructor logic here
//

}
#region IRecord override Methods
#region Wizard generated sample code (commented)
/// <summary>
/// To change Window messages filter, implement this method.
/// The default implementation is to get only the control's
/// Windows messages.
/// </summary>
public override WND_MsgFilter GetWndMessageFilter()
{

return(WND_MsgFilter.WND_MSGS);
}

/*
/// <summary>
/// To catch Windows messages, you should implement this method.
/// Note that this method is called only if the CustomServer is running
/// under UFT process.
/// </summary>
public override RecordStatus OnMessage(ref Message tMsg)
{

// TODO: Add OnMessage implementation.
return RecordStatus.RECORD_HANDLED;

}
*/
#endregion

/// <summary>
/// If you are extending the Record process, you should add your event
/// handlers to listen to the control's events.
/// </summary>
public override void InitEventListener()
{

TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
oControl.ButtonClick += new
TD.SandBar.ToolBar.ButtonClickEventHandler(oControl_ButtonClick);
//AddHandler("ButtonClick", new
//TD.SandBar.ToolBar.ButtonClickEventHandler(oControl_ButtonClick));

}

/// <summary>
/// At the end of the Record process, this method is called by UFT to
/// release all the handlers the user added in the InitEventListener method.
/// Note that handlers added via UFT methods are released by
/// the UFT infrastructure.
/// </summary>
public override void ReleaseEventListener()
{

TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
oControl.ButtonClick -= new
TD.SandBar.ToolBar.ButtonClickEventHandler(oControl_ButtonClick);

}
#endregion

#region Record events handlers
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private void oControl_ButtonClick(object sender,
TD.SandBar.ToolBarItemEventArgs e)

{
TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
// Add a step in the test for the test object with the ClickButton method
// and the tooltip text as an argument
base.RecordFunction("ClickButton",

RecordingMode.RECORD_SEND_LINE, e.Item.ToolTipText);
}
#endregion
#region Replay interface implementation
public void ClickButton(string text)
{
TD.SandBar.ToolBar oControl = (TD.SandBar.ToolBar)SourceControl;
//Find the correct item in the toolbar according to its tooltip text.
for(int i=0; i<oControl.Items.Count; i++)
{

//Found the correct ButtonItem
if(oControl.Items[i].ToolTipText == text)
{
// Retrieve the rectangle of the button's boundaries and
// locate its center
System.Drawing.Rectangle oRect=oControl.Items[i].ButtonBounds;
int x = oRect.X + oRect.Width/2;
int y = oRect.Y + oRect.Height/2;
//Click the middle of the button item
base.MouseClick(x, y, MOUSE_BUTTON.LEFT_MOUSE_BUTTON);
break;
}

}
//Add the step to the report
base.ReplayReportStep("ClickButton",

EventStatus.EVENTSTATUS_GENERAL, text);
}
#endregion

}
}
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on UFT .NET Add-in Extensibility, 11.50 Developer Guide

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to DocTeam_UFT@hp.com.
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